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The information in this document is subject to change without notice. No part of this document may be
copied or reproduced in any form or by any means without the prior written consent of NEC.  NEC
assumes no liability for infringement of patents or copyrights of third parties by or arising from use of a
product described herein.

NEC Corporation (NEC) established proven quality assurance procedures for all products
manufactured by or on behalf of NEC. As part of product qualification process an intensive release test
procedure has been established and executed before the products are released for mass production
and delivered to our clients. NEC Electronics Europe GmbH (NEC-EE) on behalf of NEC would like to
inform, that the standard quality assurance procedure(s) have not been fully applied to this product and
its documentation and that NEC cannot assure the full and error free function and/or the standard
quality level.
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FP4 complies with the EMC protection requirements

WARNING

This is a ‘Class A’ ( EN 55022 : 1998) equipment. This equipment can cause radio
frequency noise when used in the residential area. In such cases, the user/operator of
the equipment may be required to take appropriate countermeasures under his
responsibility.

EEDT-ST-001-11

CAUTION

This equipment should be handled like a CMOS semiconductor device. The user must
take all precautions to avoid build-up of static electricity while working with this
equipment. All test and measurement tool including the workbench must be grounded.
The user/operator must be grounded using the wrist strap. The connectors and/or
device pins should not be touched with bare hands.

EEDT-ST-004-10
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The information in this document is current as of May, 2006. The information is subject to change 
without notice.  For actual design-in, refer to the latest publications of NEC Electronics data sheets or 
data books, etc., for the most up-to-date specifications of NEC Electronics products.  Not all 
products and/or types are available in every country.  Please check with an NEC Electronics sales 
representative for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without the prior     
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document.
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this document 
or any other liability arising from the use of such products.  No license, express, implied or otherwise, is 
granted under any patents, copyrights or other intellectual property rights of NEC Electronics or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of a customer's equipment shall be done under the full 
responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, 
customers agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To 
minimize risks of damage to property or injury (including death) to persons arising from defects in NEC 
Electronics products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment and anti-failure features.
NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific".  
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application.  The recommended applications of an NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality grade of 
each NEC Electronics product before using it in a particular application. 

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc.  If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application.

(Note)

•

•

•

•

•

•

M8E  02. 11-1

(1)

(2)

"NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 
majority-owned subsidiaries.
"NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as 
defined above).

Computers, office equipment, communications equipment, test and measurement equipment, audio
and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots.
Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support).
Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

"Standard":

"Special":

"Specific":
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Preface

Readers This manual is intended for users who want to understand the functions of the
PG-FP4 Flash Programmer.

Purpose By using the PG-FP4, programs can be easily erased from or written to the
flash memory of an NEC on-chip flash memory microcontroller, or can be 

verified on WindowsTM screens, while the microcontroller is mounted on the
user board. 
This manual explains the basic specifications and correct use of the PG-FP4.

Organization This manual includes the following sections:

• Introduction

• Hardware installation

• Software installation

• PG-FP4 operation using GUI

• Sample programming session using GUI software

• PG-FP4 operation in stand-alone Mode

• PG-FP4 operation using terminal communication

• Sample programming session using terminal communication program

• Connectors and cables

• Design proposals for user systems

• User system interface circuits

• Error messages
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Legend Symbols and notation are used as follows:

Weight in data notation : Left is high-order column, right is low order column

Active low notation : xxx (pin or signal name is over-scored) or
/xxx (slash before signal name)

Memory map address: : High order at high stage and low order at low stage

Note  : Explanation of (Note) in the text

Caution  : Item deserving extra attention

Remark  : Supplementary explanation to the text

Numeric notation  : Binary... XXXX or XXXB
  Decimal... XXXX

  Hexadecimal... XXXXH or 0x XXXX

Prefixes representing powers of 2 (address space, memory capacity)

 K (kilo): 210 = 1024

 M (mega): 220 = 10242 = 1,048,576

 G (giga): 230 = 10243 = 1,073,741,824
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Chapter 1 Introduction

The PG-FP4 is a flash programmer for all NEC micro controllers with flash technology. PG-FP4 is
designed for both host computer controlled operation and stand-alone operation.

1.1 Main Features of PG-FP4

• PG-FP4 allows on-board programming without removing the target device from the target 
system.

• User program information is stored in the PG-FP4 internal flash memory in order to program 
target systems stand-alone without host connection of PG-FP4. The internal flash memory size 
may vary; the minimum size however, is 2 MB.

• An 8 KB EEPROM stores programming parameters.

• Serial interface connection (RS232C) to host systems, parallel interface for optional fast 
program download and USB interface are available.

• An extension interface can be configured to control PG-FP4 remotely.

• A graphical user interface is provided as well as an ASCII command line interface for terminal 
operation.

• SIO, SIO-H/S, UART, I2C or PORT interfaces are supported for data transfer to the target 
device.

• Programming Voltage VPP can be selected between 2.0 and 12.0 V.

• PG-FP4 can supply 2.0 – 6.0 V on VDD line (200 mA max.).

Note: PG-FP4 does not require any calibration due to the nature of internal design of this product
(internal regulator).
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Chapter 1 Introduction
1.2 PG-FP4 Functional Specification

Notes: 1. Not supported on Windows 95 and Windows NT

2. The maximum communication rate of the interface varies depending on the device used
and the environment.

3. VDD supplies power to the target device. The power is not intended to operate any target
system of the user. Use the power supply on the target for on-board program writing.

4. From control code G onwards, VPP, VDD, VDD2 and all target interface signals are addition-
ally voltage protected by zener diodes (VPP: 13 V, all others: 6.8 V). If the supply voltage
from the target exceeds those limits, the protection diodes in PG-FP4 may be damaged.

Table 1-1: PG-FP4 Functional Specification

Item Specification

Host interface

RS-232C:
D-SUB 9-pin, 9600, 19200, 38400, 57600 or 
115200 bps

USBNote 1:
USB type ‘B’ connector. USB conforms to USB 
Rev. 1.1

Extension Connector: D-SUB 25-pin (receptacle)

Target 

interface 

Notes 2, 4

Connector: HD-SUB 15-pin (receptacle)

Level conversion: Within VDD input range (2.0 to 6.0 V)

Protection:
Overvoltage input protection circuit 
(guaranteed range: 15 V max.)

Supported interface: 3-wire (max. 2.5 Mbps)

3-wire + handshake (max. 2.5 Mbps)

UART (max. 153600 bps)

I2C (max. 100000 bps)

PORT (max. 100000 bps)

Supply 

voltage 

Notes 3, 4

Target VPP supply voltage: 2.0 to 12.0 V max 200 mA

Target VDD / VDD2 supply voltage: 2.0 to 6.0 V max 200 mA

An overcurrent protection circuit is provided for VPP, VDD and VDD2

Supply 
voltage input
Note 4

Target VDD / VDD2 supply voltage input: 2.0 to 6.0 V max 50 mA

CPU clock sup-
ply

A 20-, 16-, 12-, 10-, 8-, 6-, 5-, 4-, 2- or 1-MHz clock can be selected as the target CPU clock.
The on-board target clock can be also used depending on the application settings.

Stand-alone
Programming without host PC
Functions such as E.P.V., ERASE, PROGRAM and VERIFY can be selected and 
executed with the Next and Enter keys.
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Chapter 1 Introduction
1.3 PG-FP4 Configuration in Host Control Mode

The configuration of PG-FP4 in host control mode is shown in below diagram:

Figure 1-1: PG-FP4 in host control mode

The graphical user interface program (GUI) for PG-FP4 supports target program download / upload,
selection of user defined parameter setup, modification of a target program downloaded to PG-FP4,
calculation of a memory checksum and various device commands to program and verify flash 
programming. General and user defined parameter setup data is saved in PRM files and SET files resp.
These files are downloaded to PG-FP4 and kept in an internal EEPROM to have parameters available
for stand-alone mode. The GUI starts up using most recent settings and saves modified settings in an
INI-file. Communication between GUI and PG-FP4 may be logged in an ASCII file.
PG-FP4’s internal memory consists of 2 MB (or more) flash memory to hold the target program to be
flashed into the target device. This memory area (progarea) may be split up into two independent mem-
ory areas of e.g. 1 MB each so that PG-FP4 may keep two different target programs for alternative pro-
gramming.

This manual familiarises with hard- and software of the PG-FP4 package.

Chapter 2 describes the hardware components and the installation of PG-FP4.

Chapter 3 describes the installation of the GUI and the required steps to upgrade PG-FP4 firmware, if
necessary. Reading this chapter is very important as soon as firmware upgrades become available.

Chapter 4 describes the GUI software.

Chapter 5 shows in a sample session how to program flash devices using the GUI.

Chapter 6 describes how to use PG-FP4 in stand-alone mode without any PC or terminal connected.

Chapter 7 describes all control and device commands which are available for operating PG-FP4 in 
terminal mode.
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Chapter 1 Introduction
Chapter 8 shows in a sample session how to program flash devices using a terminal program.

Chapter 9 describes connectors and cables of the PG-FP4 package.

Chapter 10 and chapter 11 contain design proposals for user systems.

Chapter 12 contains the error messages and recommended work-arounds.

It is strongly recommended to read the README.TXT file additionally to this manual. The
README.TXT file contains last minute information and may contain valuable hints of any kind. The
README.TXT is available on the CD-ROM of the PG-FP4 package. 
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Chapter 2 Hardware Installation

2.1 System requirements

2.2 Package Contents

Please verify that you have received all parts listed in the package contents list attached to the PG-FP4
package. If any part is missing or seems to be damaged, please contact the dealer from whom you 
purchased your PG-FP4.

Note: Updates to this User’s Manual, additional documentation and/or device parameter file(s)
for PG-FP4, if available, may be downloaded from the NEC WEB page(s) at 

http://www.eu.necel.com/update

HOST PC IBM PC/AT compatible PC equipped with PentiumTM (800 MHz or higher is 
recommended) supporting Windows 95, Windows 98, Windows NT 4.0, 
Windows Me, Windows XP or Windows 2000 is required to run the PG-FP4 user
interface program.
32 MB of RAM or more is recommended. For terminal operation of PG-FP4 any
terminal program supporting RTS/CTS handshake may be used. 

Host interface Serial interface (RS232C) capable to handle communication at 9600 (minimum)
baud up to 115200 baud.
Alternatively, an USB port (Rev 1.1) connection may be used.
A parallel port may be used in addition to the serial interface to enable fast data
download to PG-FP4. 

File formats Program files must be available in Motorola S file format or Intel HEX file format.

GUI The graphical user interface (GUI) is available for Windows 95, Windows 98, 
Windows NT 4.0, Windows Me, Windows XP or Windows 2000 operating sys-
tems. About 8 MB of free hard disk space is required to install the GUI software.

Compatible MCU All NEC devices with flash technology can be programmed.
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Chapter 2 Hardware Installation
2.3 System configuration and components

The PG-FP4 system configuration is as given in the diagram below:

Figure 2-1: PG-FP4 system configuration

PG-FP4 is connected to the host system via RS232C serial interface cable or USB port cable. An
optional parallel interface connection to the host system printer port may be established using the
extension connector of PG-FP4. The extension port can only be used for fast program download to 
PG-FP4. 
PG-FP4 is connected to the user system by a target cable. For any detailed specification of the target
cable please refer to the chapter “Connectors and Cables” of this documentation.

Remark: The parallel port interface cable is not part of the PG-FP4 package! 

2.3.1 Host computer

A PC is used to communicate with PG-FP4. The PC must support a terminal program to communicate
to the PG-FP4 command line interface via serial line including RTS/CTS handshake. For GUI operation
of PG-FP4 Windows 95, Windows 98, Windows NT, Windows Me, Windows XP or Windows 2000 must
be available.
It also must be equipped with a serial interface or an USB port. An optional parallel interface may be
used for fast program download to PG-FP4.

Caution: USB support is not available on Windows 95 and Windows NT! 
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Chapter 2 Hardware Installation
2.3.2 PG-FP4 control panel and connectors

Figure 2-2: PG-FP4 top view

The control buttons are used in stand alone operating mode of PG-FP4. 

Next button Proceeds to the next menu item in sequence.

Enter button Selects the item shown in the message display. 

Cancel button Cancels the current selection and returns to the previous menu item.
Pushing this button also cancels flash device commands such as
Erase, Program, Verify, Blank-check, etc.

Message display A 16 *2 characters LCD display informs about the operating mode. It is
mainly used for PG-FP4’s stand alone operation mode.

Status indicator The LED shows the PG-FP4 operating status, indicated by the colours
green for OK, red for Error or yellow for Operating.
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Chapter 2 Hardware Installation
The serial connector, the target connector and the power connector are located on the right side of 
PG-FP4.

Figure 2-3: PG-FP4 target device / power / serial host connectors

The parallel connector and USB port are located on the left side of PG-FP4. The extension connector
may be configured as centronics interface (default) for fast program download or as I/O port for remote
operation of PG-FP4. 

Figure 2-4: PG-FP4 extension connector / USB port interface

2.3.3 User system

The user system must be equipped with a device interface according to the target cable specification.
For any detailed specification please refer to the chapter “Connectors and Cables” of this document.

2.3.4 Power supply

The power supply FW7207/15 is equipped with a DC-plug 2.1 x 55 x 14 and may be connected to
mains using one of the available AC-plugs Euro, UK or USA / Japan.

For a specification of the power supply please refer to the chapter “Connectors and Cables” of this 
document.

Caution: Do not use any other AC adapter! Connect only the provided AC adapter to the power
supply jack!
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Chapter 2 Hardware Installation
2.3.5 RS232 Host connection

The RS232 host interface enables communication to the PG-FP4. A terminal program or the Windows 95/
Windows 98 / Windows NT 4.0 / Windows Me / Windows XP / Windows 2000 GUI may be used to oper-
ate PG-FP4, which is connected to the serial port. RS232 data transfer starts at 9600 baud, 8 data bits,
1 stop bit, no parity and hardware handshake.
The baudrate may be selected form 9600 bps (default), 19200 bps, 38400 bps, 57600 bps or 
115200 bps.

For a detailed specification of the host interface please refer to the chapter “Connectors and Cables” of
this document.

2.3.6 Extension connector

The extension connector may be configured in one out of two possible configurations:

• Centronics Interface configuration
Configured as centronics interface program data can be downloaded to PG-FP4 via high speed
parallel port from the host system.

• I/O port configuration
Configured as I/O port PG-FP4 can be controlled remotely. Via I/O port start signal an ERASE-
PROGRAM-VERIFY sequence can be started and PG-FP4 signals status information as device
connected, busy, OK and error via I/O signal lines.

For a detailed specification of the extension interface please refer to the chapter “Connectors and
Cables” of this document.

2.3.7 USB port

The USB port conforms to Rev. 1.1. It supports communication speed of 12 Mbit/s on an USB type B
connector.

Remark: USB support is not available on Windows 95 and Windows NT! 

2.3.8 Target cable

The target cable is compatible with all NEC flash programming adapters FA-XXX-YY and 
FA-XXXYY-ZZZ(-A). 
The programming adapter are products of Naito Densei Machida Mfg. Co., Ltd (NDK), Japan.
 

XXX: 20-pin, 28-pin, 30-pin, 42-pin, 44-pin, 64-pin, 80-pin, 100-pin and 144-pin.
YY: Package type GC, GF, GJ, GK, GS and CT.
ZZZ: Lead frame code.

For a detailed specification of the target cable please refer to the chapter “Connectors and Cables” of
this document.

Caution: When using the I2C interface to program a target device, make sure that SI and SO
signals lines are externally short-circuited.
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2.3.9 Caution about Potential Difference

Before connecting your hardware containing the target device to PG-FP4 via target cable, make sure,
that both grounds have the same potential (see also ‘Caution’ notice on page 4).

If this is disregarded, either the target interface of PG-FP4 or parts of your hardware may be
damaged.

On PG-FP4 side, you can use e.g. the Extension connector (Signal VSS) or the host connector (signal
GND) for grounding purposes. For pinout details, please refer to chapter 9.3 and 9.6.
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Chapter 3 Software Installation

3.1 Graphical User Interface

The PG-FP4 graphical user interface software allows easy and most comfortable access to all features
of the PG-FP4 flash programmer. It requires Windows 95, Windows 98, Windows NT 4.0 or higher, 
Windows Me, Windows XP or Windows 2000 as operating system.

3.1.1 GUI Installation

The installation program is located on the CD-ROM, which is delivered with the PG-FP4 package.
To install the GUI software, please perform following steps:

⇒ Insert the CD-ROM into your CD-ROM drive. A setup screen opens automatically.

⇒ If the setup screen does not open automatically, click the Windows START button.
⇒ Click RUN.
⇒ Type in or select ‘<CDROM drive letter>:\autorun.exe’.
⇒ Click the OK button.

Now the setup intro screen appears.

Figure 3-1: Setup intro screen
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Chapter 3 Software Installation
When Install FP4 GUI is activated, the setup program starts.

During initialisation of the setup program a progress bar is shown.

Figure 3-2: Setup preparation

Install FP4 GUI Runs SETUP.EXE from the SETUP directory.

Show the README file Opens NOTEPAD to show the README file.

Show the User’s Manual Opens Acrobat Reader to show the User’s Manual.

Exit Exits from the intro screen.
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Chapter 3 Software Installation
After a short while of initialisation the welcome screen appears:

Figure 3-3: Welcome screen

Click Next to continue the installation.
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Chapter 3 Software Installation
The License Agreement window appears:

Figure 3-4: License Agreement window

Click Accepted to continue the installation. If you click Not accepted the installation procedure exits.
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Chapter 3 Software Installation
The Choose Destination Location window appears:

Figure 3-5: Choose Destination Location window

You might exit the installation by clicking the Cancel button.
You can click the Browse button to be able to change the installation destination path.
Pressing the Next button will proceed to the Setup Program Folder selection.
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When activating the Browse button, the Choose Folder window appears:

Figure 3-6: Choose Folder window

Here you can change the destination path. Then click OK to accept the changes or click Cancel to
undo the changes. You will return to the Choose Destination Location window (Figure 3-5).
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When the Choose Folder window is closed, press the Next button in the Choose Destination Location
window. The setup procedure opens the Select Program Folder window. By default a program group 
NEC Tools32 will be created for the PG-FP4 files. You may change the folder name by selecting one of
the existing folders or by typing a new folder name in the edit field.

Figure 3-7: Select Program Folder window
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Chapter 3 Software Installation
When the correct folder has been selected, the Next button will show a summary of your selections:

Figure 3-8: Start Copying Files window

Click the Next button to start the copy process. On the installation progress window you can follow the
installation. 

Figure 3-9: Installation progress window

You can always abort the installation with the Cancel button.
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Chapter 3 Software Installation
When the installation is complete, the following message window appears:

Figure 3-10: Setup is complete

The program has been installed successfully and an entry has been made into the program menu to
start the PG-FP4 software. Select the view README.TXT checkbox to start Notepad showing you the
README.TXT file. Since this file is copied into your PG-FP4 directory anyway you may review it at later
times. Press the Finish button to exit the installation.

The installation process is complete now and the setup utility has installed a new program folder which
holds the PG-FP4 GUI Software and a PG-FP4 unInst icon which allows to delete the PG-FP4 GUI 
software if it is not used any more.
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Figure 3-11: Program folder after installation

Figure 3-12: PG-FP4 Icons 

Opens the README file for PG-FP4

Starts the PG-FP4 GUI

Starts the PG-FP4 On-line Help

Un-install PG-FP4 from the computer
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Chapter 3 Software Installation
The setup program installs following files on your hard disk:

Caution: The parameter files for PG-FP4 must be downloaded separately from the NEC WEB
page(s) at http://www.eu.necel.com/update.

C:\...\NECTools32\PG-FP4

Readme.txt Last minute information

FP4.EXE PG-FP4 GUI

FP4COM.DLL Communication DLL

FP4.HLP On-line help file

FP4.CNT On-line help contents file

FP4.INI Initialisation file

C:\...\NECTools32\PG-FP4\prm

<empty> Storage place for flash parameter files for target devices 

C:\...\NECTools32\PG-FP4\set

<empty> Storage place for user defined flash parameter files

C:\...\NECTools32\PG-FP4\drivers

USBIOWIZ.INF Driver installation INF file

USBIO.SYS USB driver for Windows 98, Windows Me, Windows 2000,
Windows XP
35User’s Manual U15260EE3V1UM00



Chapter 3 Software Installation
3.1.2 USB driver installation

When PG-FP4 is connected first time to an USB interface, Windows 98, Windows Me or Windows 2000
will detect PG-FP4 automatically and start its hardware assistant:

Figure 3-13: PG-FP4 connection to USB port detected

Windows then tries to install the necessary USB drivers for this device:

Figure 3-14: Installation of USB driver message

The next dialog requests to select the directory containing the USB driver files for PG-FP4:

Figure 3-15: USBIO driver selection (1)

Click the Browse… button and select the sub-directory drivers, which has been created in the PG-FP4
installation directory during GUI setup:
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Figure 3-16: USB driver directory selection

Click the OK button in the Open dialog and then the OK button in the driver selection dialog.

Figure 3-17: USB driver selection (2)

Windows will install the drivers and PG-FP4 becomes ready for communication via USB port.
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3.1.3 GUI un-installation

Un-installation of PG-FP4 GUI and all its components can be done by clicking the FP4 unInst icon from
the PG-FP4 program folder or by selecting Add/Remove Programs from the Window’s Control Panel.

(1) GUI un-installation using FP4 unInst 

(2) GUI un-installation using Window’s Add/Remove Programs 

Once all components of PG-FP4 GUI have been installed, clicking the FP4 unInst icon
will start the un-installation procedure: 
All files installed during setup will be removed from your hard disk except the flash
parameter files (PRM files) and customer setting files (SET files).

Click the Windows START button, go to the Settings → Control Panel and select the 
Add/Remove Programs icon.
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The Add/Remove Programs Properties windows opens:

Figure 3-18: Add/Remove Programs Properties window

Select the NEC PG-FP4 application (can be listed also as PG-FP4) from the list box and click 
Add/Remove.

All files installed during PG-FP4 setup will be removed from your hard disk except the flash parameter
files (PRM files) and customer setting files (SET files).

3.2 Terminal installation

If a terminal program is used as communication interface no installation is necessary. 

Start communication with PG-FP4 using 9600 bps, 8 data bits, 1 stop bit, no parity and select hardware
handshake. Once communication is established you may switch to 19200 bps, 38400 bps, 57600 bps or
115200 bps.

Make sure that communication is done in lower case letters only.

Caution: The parameter files for PG-FP4 must be downloaded separately from the NEC WEB
page(s) at http://www.eu.necel.com/update.
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3.3 Firmware and GUI update installation

In order to guarantee proper operation of PG-FP4 programmer it is mandatory that the correct firmware
version is available in the programmer’s internal memory. 
The GUI will perform a crosscheck about software versions installed. In case the GUI is out-of-date, a
warning message will appear:

Figure 3-19: Warning about out-of-date GUI

If the firmware is out of date, the GUI will warn also:

Figure 3-20: Warning about out-of-date firmware version

In both cases, a software update is recommended. Please, check the NEC WEB page(s) at 
http://www.eu.necel.com/update and download the necessary software update packages.
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3.3.1 Firmware update installation 

PG-FP4 is equipped with a self-programming mechanism so that downloading the new firmware 
program to PG-FP4 and starting the update procedure does not require any other equipment than 
PG-FP4 itself.
The firmware update may be installed using the GUI or any terminal communication software. Before
such process starts, the firmware update shall be copied onto the hard disk of the PC.
A typical name of the firmware program file is FP4_VUP_xxxx.REC, where xxxx is the version number
of this firmware.

(1) Firmware update by GUI

The firmware update procedure starts when you press the Yes button in the firmware update error 
message (Figure 3-20). From the appearing File open dialog select the firmware update program file
FP4_VUP_xxxx.REC. Several commands will be sent to PG-FP4 and a progress indicator informs
about download progress. 
Refer to section Update Firmware in the chapter “PG-FP4 Operation using GUI”.

As soon as the firmware is complete, a message will indicate this:

Figure 3-21: Firmware update complete message

PG-FP4 is now ready for operation.
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(2) Firmware update by terminal commands

When you are using a terminal program, firmware updates procedures can only be started on user
request. To start firmware update, enter the version update command:

version_up R

PG-FP4 asks for user confirmation before starting the update sequence:

Are you sure you want to update bootloader and firmware (y/n)?

Enter y to continue. PG-FP4 displays: 

Erasing external Flash...OK
Now loading Firmware...

At this stage, PG-FP4 waits to receive the new firmware in S-Record format. From your terminal 
program, select SEND ASCII FILE menu and browse for the new firmware data file you downloaded
from the NEC WEB site. Once the file is downloaded, PG-FP4 displays information about processing:

     **** CAUTION ****
Now bootloader and firmware will be programmed.
Please ensure that:
 - the correct bootloader file has been downloaded
 - the power is NOT disconnected during this operation
 - the programmer is NOT reset during this operation
Do you want to continue (y/n)?

Enter y to continue. PG-FP4 displays:

Selfprogramming Area(s): 0,1 (Bootloader + Firmware)
Copy Selfprog Library into RAM... OK.
Checking Vpp...OK.
Performing blank check...
not blank, performing erase... OK.

Programming the device................................... OK.
Doing verify...
Performing blank check...
not blank, performing erase... OK.

Programming the device................................... OK.
Doing verify... OK.

Programming successful. Restarting FP4.

PG-FP4 will restart and the new firmware version number will be shown on the initial screen.
42 User’s Manual U15260EE3V1UM00



Chapter 4 PG-FP4 Operation Using GUI

4.1 Getting started

Before you start using PG-FP4 you have to make sure that the correct flash parameter file (PRM file) for
your target device is installed.

Caution: PRM files are not part of the PG-FP4 software package! They have to be downloaded
from the NEC WEB page(s) at http://www.eu.necel.com/update.

PRM files downloaded from the NEC WEB site(s) must be copied into the sub-directory 
<PG-FP4 install path>\PRM, which has been created as an empty directory during GUI setup
(see chapter Software Installation). If no PRM file has been installed before, the GUI will report an error
and it will not start-up:

Figure 4-1: Error: No PRM file installed

4.2 Start-up the GUI

When PRM file(s) have been installed, connect PG-FP4 to your host computer using the provided serial
interface cable and the ‘Serial Host’ connector. After connecting the power supply to PG-FP4 and
mains, the message display shows the ‘Commands >’ prompt and the status LED is switched off. 
PG-FP4 starts up communication using the most recently used communication parameters stored in its
internal EEPROM. Default communication speed is 9600 bps.
When being started, the GUI establishes connection to PG-FP4 also using the most recently used 
communication parameters, which are stored in the FP4.INI file. When there is no FP4.INI file available
(this is the case when starting the GUI for the very first time), the GUI scans all serial 
communication ports using different baud rates to establish connection to PG-FP4.

Figure 4-2: Port scanning at start-up of the GUI
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You may wait until the communication channel has been detected automatically or you may interrupt
this operation and select the correct communication parameters in the Programmer → Setup host 
connection... menu.

As soon as communication is established, the main window appears.

Figure 4-3: PG-FP4 main window

The programs main window consists of 

• the File Checksum information section at the bottom of the right side of the main window, which 
shows the last checksum value, which has been calculated by using the File → Checksum 
menu.

• the menu at the top of the window

• the toolbar below the menu with buttons for most important program options

• the status bar at the bottom of the window 

• the parameter information section at the right side of the main window which informs about 
programming parameter settings

• the communication window which displays all commands sent to PG-FP4 and the returning 
messages from the programmer.
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4.3 The Toolbar

The toolbar contains buttons to start the most important procedures of the PG-FP4 quickly.

Table 4-1: Toolbar buttons 

Depending on the actual target device status or device type some toolbar buttons may be disabled.

Menu Device Setup
Select Programming 
area

Device EPV 

Menu File Download Device Erase Device Blank check 

Menu File Upload Device Program 

Menu HEX Editor Device Verify 
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4.4 The Menu

Depending on the actual target device status or device type some menu items may be enabled or 
disabled, i.e. the menu Device → Erase is only enabled when a device is connected.

4.4.1 File Menu

The File menu allows starting a HEX file editor and to select a program file in various formats for 
download to and upload from PG-FP4. Also a checksum calculation can be executed.

Figure 4-4: Menu item File
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(1) Hex Editor 

Figure 4-5: HEX Editor file open window

From the Files of type list box, HEX Files or SREC Files may be selected. 

The HEX Editor menu allows to edit a program file in Intel HEX file format or Motorola 
S-Record format. A HEX editor window opens and in a file open dialog the file to be edited 
can be specified.
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After selecting a file to open, the HEX editor main window loads the file and displays its contents.

Figure 4-6: HEX editor main window

Modification of the displayed file can be done by placing the mouse cursor inside the HEX editor main
window and data input via keyboard is accepted for all shown memory locations.
The HEX editor accepts data only in hexadecimal format, i.e. figures 0-9 and letters A–F. Any other data
will be rejected.
The ASCII representation, if any, is shown at the right side of the main window. This area is meant to be
for reference only. Data input is not possible in the ASCII window.
Use the scroll bar to move another address range into the visible area of the HEX editor. The address
space shown in the HEX editor window is limited to 4 MB.
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Keyboard data input functions:

Table 4-2: HEX editor key functions 

If at least one change has been made to the edited file, the HEX editor File → Save and File → Save
As… menu items will be enabled to save the modified data.

The Save menu item saves the file in its original file format and file size while Save As… allows to
specify different options:

Figure 4-7: HEX Editor Save As... dialog

Beside file name and directory location, Save As… allows selecting a different start address and a 
different end address for the new file. The original start address and end address is offered as default
selection. Also, the output file format may be selected as Intel HEX or Motorola SREC formats. 

Key Function

0-9, A-F Data entry

> Move cursor in right direction

< Move cursor in left direction

^ Move cursor in upper direction

V Move cursor in lower direction

T Move cursor to the next input field
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(2) Download 

Figure 4-8: File selection window for program download

The most recently used directory a file has been downloaded from will be offered in this download 
menu. The directory name will be saved in the key FileDownloadDirectory... of the 
[Programmer] section of PG-FP4.INI file. After program download a CRC will be calculated covering 
the selected programming area and the CRC will be stored in the key FileDownCrcSum... of the 
[Programmer] section of FP4.INI file. The CRC will be used to verify PG-FP4s memory contents 
before an autoprogramming sequence is started. The name of the download file is saved in the key 
DownloadFileName... of the [Programmer] section of FP4.INI file.
Erase memory before download can be selected to clear PG-FP4s memory contents before the new 
program is downloaded.
The Open button starts the download procedure.
The Cancel button closes the window without downloading the program.

The Download menu allows selecting and downloading a program file into the PG-FP4
flash memory. After downloading the program file may be programmed into the device’s
flash memory.
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(3) Upload 

Figure 4-9: File selection window for program upload

In the appearing window you can 

• Select a program file for upload

• Select the upload file format (Intel HEX or Motorola S-Record format)

• Select the memory start- and end addresses to upload

The most recently used directory a file has been uploaded to will be offered in this download menu. The
directory name will be saved in the key FileUploadDirectory of the [Programmer] section of 
FP4.INI file. Also the file format, start address and end address will be saved in specific keys of the
FP4.INI file.

The Open button starts the upload procedure.
The Cancel button closes the window without uploading the program.

The Upload menu allows specifying and uploading a program file from PG-FP4 flash 
memory to disk.
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(4) Checksum 

The Checksum menu may be used to verify that PG-FP4’s flash memory area contains the correct
download file. 

Figure 4-10: Checksum dialog window

Two variants of checksum are available, which are selected from the drop down menu:
- CRC sum (32 bit)
- Arithmetic checksum (16 bit)

The arithmetic checksum algorithm is the same, that is used inside the device, if it supports the 
‘Checksum’ command (see also ‘Device’ menu).

Select Check Complete Programmer Application Memory if a checksum shall be calculated cover-
ing the whole programming memory area.

Select Device Area to calculate a checksum of the memory area according to the target device.

Select User Defined if a CRC shall be calculated over any other memory area. As soon as this option
is enabled, the memory Start Address and memory Length need to be specified.
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The requested checksum type is calculated by PG-FP4 and displayed in the communication window.
Additionally, it is shown in the main window (see Figure 4-11 below) and stored in PG-FP4’s EEPROM
memory. See chapter 6 how to display the checksum value in Stand-Alone mode.

Note, that the file checksum described here is never calculated and displayed automatically after a file
download. This must be done manually after loading a new file.

Figure 4-11: Main window – File checksum

Remark: If programming areas are enabled, the checksum calculation and address data apply to the
active programming area only! 
For reference, Programming Area shows the currently selected programming area.

Source code of the CRC32 function used is provided in chapter PG-FP4 operation using terminal 
communication, section crc command. 

(5) Quit

The Quit menu terminates the interface program and returns control to the operating system. User 
settings are saved in the FP4.INI file so that PG-FP4 GUI will start up next time with the same 
settings.
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4.4.2 Programmer menu

The Programmer menu allows selecting the communication channel and corresponding 
communication parameters. A log file may be specified to monitor the communication to and from 
PG-FP4. The default programming area may be selected, the PG-FP4 reset command and a menu 
item to update PG-FP4 firmware are available. 

Figure 4-12: Menu item Programmer

(1) Setup host connection

At startup the GUI automatically tries to connect to PG-FP4 using the parameters 
HostConnectionSpeed, HostConnectionPort and HostDownloadPort of the section [GUI] 
of FP4.INI.
If this connection cannot be established, the GUI tries to connect via COM1 … COM4, using 
9600 baud, 19200 baud, 38400 baud, 57600 baud and 115200 baud on each port until it succeeds.

Additionally, manual selection of the communication channel and communication settings for the 
connection between PG-FP4 and the PC can be done in this dialog:

Figure 4-13: Host Connection dialog

You may select USB as communication channel, if USB is supported on your PC.
For Serial communication Port and Baud rate may be selected from the drop down list boxes.
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Use parallel Download can be selected in addition to the serial port. If parallel download is selected,
data download to PG-FP4 is performed via the selected parallel interface. Despite of this selection,
command communication will still be done via the serial interface.

Cautions: 1. The parallel interface cable is not part of the PG-FP4 package!

2. Using the parallel port requires that the LPTx port must not be captured by the 
operating system! For details, please refer to the documentation of your 
operating system.

3. USB communication is not supported on Windows 95 and Windows NT!

Clicking the Cancel button closes the window without changes.
By clicking the OK button the GUI establishes a connection between PG-FP4 and PC using the
selected communication parameters.

(2) Logging

The Logging menu opens a file open dialog to select the log file name. The log file will capture the
communication between the PC and PG-FP4. 

Figure 4-14: Log file dialog

Once logging is enabled, a check mark in the Logging menu indicates that logging is active. Selecting
the menu again will close the log file and stop any further communication logging.
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(3) Select Programming area 

Figure 4-15: Programming area selection

The PG-FP4 internal memory is split into two independent memory areas of same size, which may hold
two different application programs for flash programming. When opening this dialog, the current pro-
gramming area selection will be displayed.
Additionally, the size of the memory area is displayed in the communication window (be sure to have
latest firmware version running for this feature); e.g.:

Active Program Area: 0
Max. program size: 2 MByte
>

The programming area size depends on the hardware version of your PG-FP4. Minimum is 1 MB; from
control code H onwards it is 2 MB.

This feature needs to be enabled in the parameter (PRM) file or customised parameter (SET) file.

(4) Reset

The Reset menu sends a software reset command to the programmer. The reset performs software 
reset to the PG-FP4 microcontroller. All voltages (VPP, VDD and VDD2) will be switched off.  After reset 

the communication window will show the current version of PG-FP4 firmware.

The Select Programming area menu allows selection of one out of two different 
programming areas of PG-FP4.
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(5) Update Firmware

The Update Firmware menu initiates the PG-FP4 firmware update sequence. Before starting the 
update sequence, make sure that you have downloaded the requested update file(s) from the NEC 
WEB page(s) at http://www.eu.necel.com/update.
When the Update Firmware menu is activated PG-FP4 will ask for confirmation first:

Figure 4-16: Firmware Update confirmation

Press the Yes button to continue firmware update or press the No button to cancel.
After pressing the Yes button, the firmware update file in S-record format must be selected: 

Figure 4-17: Select firmware update file

After selecting the requested file, the Open button starts the various steps of the update sequence.
While the update is running, an indicator shows the progress of the update activities. Also the 
command window shows several messages according to the update steps currently under execution.
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Figure 4-18: Firmware update in progress

The GUI will indicate as soon as the firmware update is completed.

Figure 4-19: Firmware update complete message

PG-FP4 will execute a reset command and re-starts operation using the new fimware version.
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4.4.3 Device Menu

The Device menu item offers commands to control PG-FP4. Some menu items may be inactive if 
PG-FP4 has not been connected to the target device or if items are not available for the target device 
connected to PG-FP4.

Figure 4-20: Menu item Device

(1) Blank Check 

The flash memory has to be erased first before programming may start.

Caution: The Blank check command is not available for all types of target devices!

(2) Erase 

For single-power-supply flash microcontrollers, the section Command options of the Advanced tab of
the Device → Setup menu controls if blank check before erase is executed or not.

Remark: You may abort the erase procedure by the pressing the Cancel button on PG-FP4.

After completing the erase command, the GUI displays the target device status.

The Blank check command initiates a blank check of the target device connected to 
PG-FP4. If the flash memory of the target device is erased, the blank check terminates 
successfully. If the flash memory is not completely erased, an error message is displayed. 

The Erase command initiates the erase procedure for the target device connected to PG-FP4. 
Before an erase command is executed, the device is checked by a blank check command. If 
the device is already blank, the erase command will not be executed.
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(3) Program 

It also executes verification to check if the write level is secured after the user program has been 
written.
Since programming needs some time (some seconds up to several minutes, depending on the device)
a progress window is displayed, indicating the programmers activity. The progress window shows the
percentages of the program already programmed into the device.

Remark: You may abort the erase procedure by the pressing the Cancel button on PG-FP4.

If Read verify after Program is set in the Advanced Setup section, a Verify command will be executed 
after each Program command.

After completing the program command, the GUI displays the target device status.

(4) Verify 

Since verifying needs some time (some seconds up to several minutes, depending on the device) a
progress window is displayed. In case the device needs to be verified completely, the percentages
already verified are shown. In case smaller memory areas of the device need to be verified only, a 
stopwatch is displayed indicating the programmer’s activity.

Remark: You may abort the erase procedure by the pressing the Cancel button on PG-FP4.

After completing the verify command, the GUI displays the target device status.

The Program command starts the programming procedure of the target device connected to
PG-FP4. During device programming, the memory contents of the active programming area
(0 or 1) is programmed into the erased flash memory of the target device. The section 
Command options of the Advanced tab of the Device → Setup menu controls if a Verify 
command is executed automatically after a Program command or not.

The Verify command transmits the memory contents of the active programming area (0 or 1)
to the target device connected to PG-FP4 and verifies the data against the flash memory
contents of the target device. This command does not check the write level, it checks if data
communication between PG-FP4 and the target device has been performed correctly.
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(5) Read

The Read command reads out the flash contents of the target device. The data can be 

• displayed in hexadecimal form in the communication window (Selection View)

•  saved as a file in Intel HEX format (Selection Write Intel HEX file)

•  saved as a file in Motorola S-record format (Selection Write Motorola SREC file)

Figure 4-21: Menu item Device – Read

If ‘View’ has been selected, every 256 lines the output is stopped and is continued by hitting a key on
the keyboard (e.g. blank).
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If the data should be saved as a file, a ‘Select a file’ dialog is opened:

Figure 4-22: Device Read - Save as dialog (Intel HEX)

Remark: You may abort the data output by pressing the Cancel button on PG-FP4.

The Read command is not supported for all target devices.

(6) Security

The Security command sets the security flags in the target device as specified in the device setup 
dialog, section Security flag settings.

The Security menu item is not supported for all target devices.

(7) Checksum

The Checksum command reads the checksum from the target device.

The Checksum menu item is not supported for all target devices.
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(8) Autoprocedure (EPV) 

Since the concerning steps need some time (some seconds up to several minutes, depending on the
device) a progress window is displayed, indicating the programmers activity. Regarding the selected
commands, their execution behaviour and their possible messages please refer to the corresponding
chapter(s).

Remark: You may abort the erase procedure by the pressing the Cancel button on PG-FP4.

If Read verify after Program is not set in the Advanced Setup section, the Verify command will not be 
executed.

After completing the EPV command, the GUI displays the target device status.

(9) Signature Read

The Signature Read command reads the target device name and its internal flash memory structure. 
Depending on the result of this command the GUI hides menu items not supported by the target device.

(10) Get Security Settings

The Get Security Settings command reads out the values of ‘Security Flag’ and ‘End of Boot block’
out of the target device, and stores the values as defaults for the Advanced Device Setup.

This is useful e.g. for evaluation environments, where a device may already have a Security Flag Set.

If e.g. the ‘Disable Block Erase’ is already set, and you try to set the Security Flags with ‘Disable Block
Erase’ not set, the device reports an error, because clearing a Security Flag is only possible by perform-
ing a Chip Erase.

The Get Security Settings command is not supported for all target devices.

The Autoprocedure (EPV) command starts an automatic Blankcheck - Erase - Program - Verify 
sequence. Before the EPV command starts it compares the checksum of the downloaded 
program with the checksum value in the user program area of PG-FP4. If the two values are the 
same, EPV will be executed.
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(11) Setup 

(a) Parameter files
PRM file and SET file contain parameters to configure PG-FP4 according to the flash parameter 
specification of the target device. The PRM file contains information about various timings and features
supported by the target device. Since the information in this file is very critical the user must not modify
it. For safety reason, the PRM file is protected by a checksum and PG-FP4 will neither accept a PRM
file in GUI mode nor in terminal mode if the checksum is incorrect. Renaming a PRM file is not allowed
either.
The SET file contains information about available programming interfaces for the target device, 
oscillator frequency, operating voltages, etc. and it can be tailored according to user needs. The setup
dialog of the GUI allows modifying SET file settings only.

Caution: Please make sure to select the correct PRM file according to the target device in use.
Wrong PRM file selection may damage the target device!

(b) PRM / SET file structure
A PRM file downloaded from the NEC WEB site(s) is designed to be used in GUI mode and 
terminal mode as well. A PRM file may contain parameter settings for more than one version of a
device. From the device signature PG-FP4 is able to detect which section of the PRM file is valid for the
target device. 

The Setup menu allows configuring target device interface and option settings as well as 
target environment options of the programmer. Each time the GUI starts, it reads the most
recently used customer settings file (SET) and parameter file (PRM) and fills the Properties
dialog fields and list boxes according the file contents. The standard setup dialog and the
advanced setup dialog allow modifying the customisable settings of the SET file only. The
PRM files remains unchanged always.
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Figure 4-23: PRM file structure

[PRC 0]
. . .
. . .

[PRC 1]
. . .
. . .

[CHECKSUM]
SUM = 
[EOF]

SSSSSSSS

[CustomerSetting]
. . .
[CHECKSUM]
SUM = 
[EOF]

SSSSSSSS

[FlashProParameterFile]
. . .
FNAME= xxxxxxxx
. . .

[PRC ]
. . .
. . .

n

[FlashproCustomerSettingFile]
. . . 
PRM = .PRM
[CHECKSUM]
SUM = 
[EOF]

filename

SSSSSSSS

The PRM file contains fixed device 
parameter settings and a default 
section for user modifiable settings.

The SET file contains option and 
user settings. The GUI extracts
the SET file automatically.
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(c) Standard Setup
This menu item allows to setup target device and target environment specific options of the 
programmer.
The following window opens:

Figure 4-24: Device setup window – Standard view

This window shows all basic options, which might be set depending on the target environment and 
target device. The example shown above displays some common options for the µPD70F3037 device.

Pressing the Apply button updates the selected SET file immediately with the changes selected by the
user but it does not download the SET / PRM files to PG-FP4. Changes are done permanently. The
Cancel button does not reset them.
Pressing the OK button updates the SET file according to the parameter settings of the standard and
advanced setup tabs and it downloads the PRM / SET files to PG-FP4. Settings of the SET file will thus
override the default settings of the customer setting section in the PRM file.
Pressing the Cancel button closes the dialog without updating or downloading any file. 

Remark: The Setup dialog may contain items that do not apply for the selected target device. In such
cases the selections will not be enabled.
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• Device selection

Parameter files contain the basic parameter settings for each flash device and cannot be changed. 
Customised settings are stored in SET files and do contain all those parameters, which may be
changed in the setup dialog.
Each SET file is based on the [CustomerSetting] section of a valid PRM file. To select a new
device, a previously generated SET file may be selected from the Setting file list box. The SET file and
the corresponding PRM file will be loaded then.

Figure 4-25: Setup window - Device selection

The … button allows to select SET files from a different directory than the default one.
The Save As… button allows saving current settings into an existing or new customisable SET file.
The Defaults button changes all parameters to the value given in the [CustomerSetting] of the
parameter file (PRM file).
The New… button allows to create a new customisable SET file.

Figure 4-26: Creating a new SET file

A new SET file may be created based on the default settings of an existing PRM file. The New… 
dialog requires to select the PRM file first. The list of available PRM files installed in the \PRM 
directory may be selected from the Parameter file list box.
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When a new Setting file selection has been made, the GUI extracts the name of the corresponding
PRM file from the SET file and loads the PRM file automatically. The data of the SET file will be used fill
the standard and advanced dialog elements.
Clicking the Defaults button copies the [CustomerSettings] section from the PRM file into the 
corresponding fields of the Setup dialog. Clicking the Apply button reads all dialog fields and writes the
contents to the corresponding records of the selected SET file. Clicking the OK button 
downloads the PRM file and the SET file to PG-FP4 using downprm and downset commands 
respectively.

Figure 4-27: SET file modification and download

All modifications done in the setup dialog standard and advanced tabs will affect the SET file only.
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• Communication interface to device

The communication interface to device selects the communication channel between PG-FP4 and the
target device.

Figure 4-28: Setup window – communication interface selection

From the Port list box, the communication port can be selected. The list box contains all available ports
of the target device selected.
Pulse number shows the number of pulses to be applied to VDD line to select the Port listed above.
This information is supplied for reference only.
From the Speed list box the communication speed for the selected communication channel can be 
chosen.

The IIC Address edit field allows specifying the I2C address if programming channel I2C is selected.

The I2C Address edit field will not be accessible if no I2C port is selected.

Caution: When using the I2C interface to program a target device, make sure that SI and SO
signals lines are externally short-circuited.
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• Supply oscillator

The supply oscillator selects the oscillator responsible for signal generation for programming and data
transfer and its speed.

Figure 4-29: Setup window - oscillator selection

From the Frequency list box the oscillator frequency use for signal generation can be selected.
The On Target check box specifies if clock signal is supplied from PG-FP4 or from the target hardware.
If this option is selected the Frequency cannot be selected from the list box. It must be entered manu-
ally.

Multiply rate may be set to Internal/Direct mode or PLL mode. 

For determination, if Internal/Direct mode or PLL mode has to be selected, use the following rules:

1) If the device does not have a pin (e.g. CKSEL) for switching clock generator PLL ON or OFF,
select Internal/Direct mode

2) If the device has a pin (e.g CKSEL) for switching clock generator PLL ON or OFF, or, if different
PLL factors may be used depending on clock frequency or pin level:

• select PLL mode, if your target hardware or the programming adapter defines by the select pin, 
that clock generator PLL is ON, or if more than one PLL multiply value is possible.

Do not change the default value for the PLL multiply factor, except it is explicitly noted in the chap-
ter 'Flash Memory' of the device users manual, that the multiply factor may vary e.g. depending on
the input clock frequency.

• select Internal/Direct mode, if your target hardware or the programming adapter defines by the 
select pin, that PLL is OFF and direct mode is used.
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• Operation Mode

For some flash devices the flash memory is divided into several blocks or areas.

Figure 4-30: Setup window – Operation Mode

If you select Chip, Block or Area mode, you can blankcheck, erase and verify the complete chip 
memory or single/multiple blocks or areas.

The Start and End list boxes allow selecting starting end ending block/area for the desired operation.
The Show Address checkmark allows toggling between block/area number selection and physical
address selection for the operation.

In chip mode the block/area do not apply. If you select chip mode, the required operation affects the
complete flash memory of the device.

The Selective programming checkmark allows to select programming the complete chip memory or
any selected memory area. 

The Start and End edit controls allow specifying starting and ending address for the programming
operation. The selection for start address and end address must fit into the target device’s physical
memory.

In chip mode the Start/End address selection do not apply. If you select chip mode, the required 
operation affects the complete flash memory of the device.
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(d) Advanced Setup

By clicking on Advanced tab advanced device specific options are shown.

Figure 4-31: Device setup window – Advanced view

The Advanced Setup allows specifying programming voltages, command options and security flag set-
tings for target device programming. The example shown above displays some advanced options for
the µPD70F3239 device.
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• Supply Voltage

The supply voltage section allows specifying voltage levels for target device programming. Depending
on the target device type, one (VDD) or two (VDD and VDD2) voltage levels need to be specified.

Figure 4-32: Setup window – Supply Voltage

VDD value specifies the high level voltage, VDD2 value specifies the signal low level. Values must be
entered in units of volts (V).
If On Target is selected, VDD / VDD2 voltages will be supplied form the target hardware and thus cannot
be selected in this dialog. However, voltage levels are displayed according to the requirements given in
the PRM file. 

Caution: Make sure that values for VDD and VDD2 are entered correctly before you switch to tar-
get supply!

The signal levels for VPP, Clk, Serial Port, Reset and H/S Input cannot be altered. The selections
according to PRM file are shown here.
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• Command options

The command options section allows specifying operation behaviour of PG-FP4.

Figure 4-33: Setup window – Command options

Blank check before Erase performs a blank check operation before each erase command. If the flash
memory area is already erased (blank check ok) the erase sequence will not be started.
Read verify after Program enables an automatic verify operation of the programmed flash memory
after each target device programming sequence.
When this option is set, a Verify command is executed after each Program command.
When this option is not set, the Autoprocedure (EPV) command will not execute a Verify command. 
Security flag after Program enables an automatic programming of the selected security flags after
each target programming.
The Checksum after Program performs a checksum calculation inside the target device after each 
target programming and reports the resulting checksum.
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• Security flag settings

The security flag settings specify, which of the available security features shall be enabled. Depending
on the device type, Security Flag setting is not supported at all, or only some of the Security features
are supported.

Figure 4-34: Setup window: Security flag settings

Disable Chip Erase disables further erase commands for the entire target device flash memory area.

Disable Block Erase disables further erase commands for the entire target device memory blocks.

Disable Program disables further program and block erase commands for the entire target device
memory blocks.

Disable Read disables further read-out of the target device memory.

Disable Boot block cluster reprogramming disables further erase and programming of the flash
blocks belonging to the boot block cluster; that are all blocks with number <= ‘End boot block number’.
This number is defined in the Boot Block cluster setting window (see below).

The Reset vector field allows to set the start address of the target device after RESET to any address.

In case Disable Chip Erase is set, a warning message will appear to draw the user attention to the fact
that no further erasing or programming of the target device will be possible any more.

In case Disable Boot block cluster reprogramming is set, a warning message will appear to draw the
user attention to the fact, that no further erasing or programming of the Boot block cluster will be 
possible any more.
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• Boot block cluster setting

Defines the number of the flash block, which is top of the boot block cluster.
The boot block cluster bottom is fixed to block 0.

Example: End Boot block= 3 → Boot block cluster = flash blocks 0, 1, 2, 3

Figure 4-35: Setup window: Boot block cluster setting

The Boot block cluster feature is not supported for all target devices.

• Program download/upload

Two different target programs can be downloaded into PG-FP4 and may be programmed into the target
flash device alternatively.

Figure 4-36: Setup window: Program download/upload

Enable two Program Areas enables selection of programming areas (see Programmer → Select
Programming area… menu). 
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4.4.4 Help Menu

The Help menu displays the help and about box selection.

Figure 4-37: Menu item Help

(1) Contents

The Contents menu starts the Windows Help engine and opens the contents dialog of PG-FP4 help
file. 

(2) About

The About menu opens the program entry window:

Figure 4-38: About window

It is displayed until you click on the Micro picture.
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4.5 PG-FP4 initialisation file

The PG-FP4 GUI maintains several keys of the initialisation file FP4.INI to keep actual settings and start
up with the same settings as during a previous session. FP4.INI is located in the same 
directory as FP4.EXE itself.
The initialisation file consists of several sections and keys in each section. In case a key is not available
in the corresponding section the default setting for that key will be assumed.

Default key setting(s) are marked as bold.

4.5.1 Section [GUI]

Table 4-3: Section [GUI]

Key name Setting Description 

StartWithMaximizedMainWindow 0 At startup of PG-FP4, the main window will open
with default window size.

1 At startup of PG-FP4, the main window will open
with maximised window size.

HostConnectionSpeed 9600
19200
38400
57600
115200

Specifies the communication speed. Other 
communication speeds may be selected.

HostConnectionPort COM1
COM2
COM3
COM4
USB

Specifies the communication port. Other COM
ports may be selected if available on the host PC.

HostDownloadPort COM1
COM2
COM3
COM4
LPT1
LTP2

Specifies the communication port for file 
download. 
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4.5.2 Section [Programmer]

Table 4-4: Section [Programmer] (1/2)

Key name Setting Description

RecentSetFile <string> Specifies the most recently used customisable 
settings file name.
If no file name is given, PG-FP4 will use the file 
XXX.SET in the subdirectory \SET.

FileDownloadDirectoryArea0 <string> Most recently used file download directory name to
progarea 0. If no name is given here, PG-FP4 
startup directory will be used.

FileDownloadNameArea0 <string> Name of the most recently downloaded file to 
progarea 0.

FileDownCrcSumArea0 <string> Saves the most recently used CRC as hexadecimal
value of the complete memory after user file 
download to progarea 0. In case of errors Failed will
be written into this key.

FileDownloadDirectoryArea1 <string> Most recently used file download directory name to
progarea 1. If no name is given here, PG-FP4 
startup directory will be used.

FileDownloadNameArea1 <string> Name of the most recently downloaded file to 
progarea 1.

FileDownCrcSumArea1 <string> Saves the most recently used CRC as hexadecimal
value of the complete memory after user file 
download to progarea 1. In case of errors Failed will
be written into this key.

FileDownloadDirectoryNoArea <string> Most recently used file download directory name, no
progarea selected. If no name is given here, 
PG-FP4 startup directory will be used.

FileDownloadNameNoArea <string> Name of the most recently downloaded file, no 
progarea selected.

FileDownCrcSumNoArea <string> Saves the most recently used CRC as hexadecimal
value of the complete memory after user file 
download no progarea selected. In case of errors
Failed will be written into this key.

FileChecksumType_0 <string> Type of checksum for last recently calculated file
checksum for progarea 0.

FileChecksumCS_0 <string> Checksum value for last recently calculated file
checksum for progarea 0.

FileChecksumAddress_0 <string> Address range for last recently calculated file check-
sum for progarea 0.

FileChecksumType_1 <string> Type of checksum for last recently calculated file
checksum for progarea 1.

FileChecksumCS_1 <string> Checksum value for last recently calculated file
checksum for progarea 1.

FileChecksumAddress_1 <string> Address range for last recently calculated file check-
sum for progarea 1.

FileChecksumType_2 <string> Type of checksum for last recently calculated file
checksum, progarea disabled.
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Key name Setting Description

FileChecksumCS_2 <string> Checksum value for last recently calculated file
checksum, progarea disabled.

FileChecksumAddress_2 <string> Address range for last recently calculated file check-
sum, progarea disabled.

FileUploadDirectory <string> Most recently used file upload directory name. If no
name is given here, PG-FP4 startup directory will be
used.

FileUploadFilter 1 File upload in Motorola SREC format.

2 File upload in Intel HEX format.

FileUploadStart <string> Most recently used memory start address for file
upload.

FileUploadEnd <string> Most recently used memory end address for file
upload.

Table 4-4: Section [Programmer] (2/2)
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As an example, a V850/SB1 micro microcontroller will be used to show a typical programming
sequence using PG-FP4 GUI software.

1. Use the provided serial cable to connect PG-FP4 to your host computer.

2. Use the target cable to connect PG-FP4 to the target hardware. This may either be a NEC 
FA-100-GC programming adapter or your own target hardware.

3. Select the suitable AC-plug (EURO, UK or US/JAPAN) and connect it to the AC adapter.

4. Use the AC adapter to connect PG-FP4 and mains. The status LED of PG-FP4 should be off and
the LCD display shows ‘Commands   >’ indicating that PG-FP4 is ready for operation.

5. If not yet done, install the PG-FP4 GUI software on your PC as described in the chapter “Software
Installation”. 

6. Copy the flash parameter file for V850/SB1 to your hard disk and install it into <PG-FP4 install
path>\PRM. You may obtain it from the NEC internet site http://www.eu.necel.com/update.
Make sure that you download the flash parameter files according to your device specification (ver-
sion number, mask rank).

7. Start PG-FP4 GUI software. The GUI tries to establish connection to PG-FP4 using COM1 at 
9600 bps. If this does not succeed, it will scan other communication speeds and then other ports.

Figure 5-1: Connection GUI to PG-FP4

8. You may speed up this procedure by pressing the ABORT button and select the communication
port in the Programmer → Setup host connection… menu directly:
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Figure 5-2: Setup host connection

9. Select the appropriate port number you connected PG-FP4 to. Initial communication speed shall
be set to 9600 bps (factory setting of PG-FP4).

Figure 5-3: Setup communication parameters

10. Select OK to activate the new port settings.

11. Select the menu item Device → Setup 
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Figure 5-4: Device connect menu 

Toolbar:
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12. The Standard dialog for device setup will be activated.

Figure 5-5: Device Setup Dialog
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13. To create a new SET file for the V850/SB1 device, press the New… button.

Figure 5-6: Creating a new SET file

14. Select 70F3033AK.PRM (µPD703033A, mask rank K) in the Parameter file drop down box.

Figure 5-7: Device PRM selection

15. Enter a new name for the SET file based on the 70F3033AK PRM file and save it to disk.

Figure 5-8: Save new SET file
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16. Verify that all settings shown in this dialog correspond to the needs of your target environment.
Especially Communication interface to device and Supply oscillator shall be set according to
the device interface you selected. You may also change settings for Operation Mode, if necessary
and if enabled for the selected device.

17. Switch to the Advanced dialog.

Figure 5-9: Advanced device setup dialog

18. Check Supply voltage information and make sure that the settings are according to your 
hardware environment, especially when you are going to supply VDD from your target hardware.

19. Press the OK button. The GUI loads now the parameter settings to PG-FP4.

20. Select the menu item File → Download
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Figure 5-10: Open a program file for download 

21. Select the file you would like to program into the target device. Click Open to start the 
download sequence. During program download a progress window will show the progress of
downloading.

22. Select the Device → Autoprocedure menu item. 

Figure 5-11: Erase → Program → Verify menu  

The V850/SB1 will be blankchecked, programmed and verified now. When EPV is completed, you
may take it out of the programming adapter.

Toolbar:

Toolbar:
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23. If necessary, insert a new device to be programmed into FA-XXX-YY and repeat from step 22.

24. If no other device needs to be programmed exit PG-FP4 GUI. All settings made during this 
programming session will be saved so that they can be reused GUI software is started up next
time. The file FP4.INI will keep the window layout as well as the communication settings and the
name of the SET / PRM files used. Also, all target device settings are saved in an EEPROM inside 
PG-FP4. 
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PG-FP4 provides features to allow a stand-alone programming mode. In this operation mode, neither
GUI nor terminal connection is required to program flash devices. In addition to GUI or terminal mode,
the parallel host connection may be used to control PG-FP4 remotely for blank check, erase, program
and verify operation.
In this operation mode PG-FP4 will use flash-programming parameters stored in its internal memory
area and thus it is not possible to select any new device for flash programming or alter any 
programming parameter. The most recently used type of device during GUI or terminal operation mode
can be programmed only.

For data entry and operation control the Next, Enter and Cancel buttons can be used. The LCD display
and the status LED inform about menu and parameter selections and the operation status respectively.

The various commands are organised in a three level menu hierarchy that can be stepped through
using the Next, Enter and Cancel buttons. The Next button steps to the next menu on the same level.
The Enter button selects and activates the currently displayed menu item or it performs the requested
command, depending on the current menu item. The Cancel button stops the currently executed 
command or it steps back to the previous menu level.

Figure 6-1: Menus controlled by keystrokes

On the first menu level, PG-FP4 shows the menu items that can be selected. A command prompt ‘>’
indicates that the menu can be selected by the Enter key or that a given command can be executed.
On the second menu level, the first line in the message display shows the menu item and the second
line shows the response from the PG-FP4, if any.

After connecting the power supply to mains and PG-FP4 the LCD display indicates by showing 
‘Commands >’ that PG-FP4 is ready for operation. The status LED is switched off.
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LED status indicator: 

6.1 PG-FP4 operation menu

PG-FP4 can be controlled using the commands as described in this chapter. 

Caution: Most of the commands will return useful information only if

• a valid parameter file for the device to be connected has been downloaded 
during a previous programming session

• a device corresponding to the downloaded parameter file is physically 
connected to PG-FP4 via target cable and programming adapter

• the application program to be programmed into a flash device has been 
downloaded to PG-FP4 during a previous programming session.

After those steps, the host connection is not necessary any more. An E.P.V. command or an extension
port I/O input signal can start the programming sequence of the flash device connected to PG-FP4.

Yellow

The selected command is being executed. Details of the execution status will be 
displayed on the message window.

Green

The selected command has been executed correctly.

Red

The selected command has been terminated due to an error. Details of the error 
will be displayed on the message display.
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6.1.1 Commands menu

The command menu offers various commands necessary for rewriting the target device. Select a 
command from this menu and press the Enter button to execute it.

Notes: 1. This command is not supported by all flash devices and will therefore not be displayed in all
device selections. 

2. A user program cannot be downloaded to PG-FP4 in stand-alone operation mode. It must
have been downloaded via terminal or GUI during a previous programming session.

E.P.V. > Next Enter button pressing starts the erase, program, and verify sequence of the
device connected to PG-FP4. The E.P.V. sequence affects the target memory

area (Chip, Block or Area).Note 2

Program > Next Enter button pressing starts the programming sequence of the device 
connected to PG-FP4. The Program sequence affects the target memory area

(Chip, Block or Area).Note 2

Erase > Next Enter button pressing starts the erase sequence of the device connected to
PG-FP4. The Erase sequence affects the target memory area (Chip, Block or
Area).

Verify > Next Enter button pressing starts the verify sequence of the device connected to
PG-FP4. The Verify sequence affects the target memory area (Chip, Block or

Area).Note 2

Security > Next Enter button pressing programs the security flag in the device connected to

PG-FP4. Note 1

Checksum > Next Enter button pressing starts checksum calculation function in the device
connected to PG-FP4. The checksum will be displayed on the message display.
The Checksum sequence affects the target memory area (Chip, Block or

Area).Note 1

Blank check > Next Enter button pressing starts the blankcheck sequence of the device 
connected to PG-FP4. The Blankcheck sequence affects the target memory area

(Chip, Block or Area).Note 1

Signature > Next Enter button pressing reads the signature from the device connected to 
PG-FP4. It shows the device name in the message display.

Prog Area > Next Enter button pressing switches prog area selection from 0 to 1 or vice versa.
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6.1.2 Type Setting menu

The type setting menu allows to check the target device rewrite environment currently set. The settings
cannot be changed in stand-alone operation mode. All values shown are taken from the parameter file
downloaded during a previous programming session.

Device Port Device Port shows which device port has been selected for communication to

the PG-FP4. Depending on availability SIO, SIO - H/S, UART, PORT or I2C may
be possible.

Multiply Rate Multiply Rate shows the multiplication factor of the operating clock of the target
device.

Serial CLK Serial Clock shows the actual serial clock rate in Hz for communication between
PG-FP4 and the device connected.

CLK source Clock Source shows the source of the clock for communication between 
PG-FP4 and the device. The clock signal may be provided from PG-FP4 or 
target hardware.

PG CPU CLK PG CPU Clock shows the clock frequency in MHz generated from PG-FP4. 

Target CPU CLK Target CPU Clock shows the clock frequency in MHz of the user system 
supplied to the target device. 

Mode Mode shows the operation mode for blankcheck, erase, program and verify
commands. This mode may be chip mode, area mode or block mode.

PRG Area Prog Area shows, which area of the device connected to PG-FP4 will be 
programmed. The units shown depend on the selection of the Mode command
and can be counted in flash areas or flash blocks.
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6.1.3 Options Setting menu

The option setting menu allows checking the command options and security flag settings currently set.
The settings cannot be changed in stand-alone operation mode. All values shown are taken from the
parameter file downloaded during a previous programming session.

BLN before ERS Displays the status of the command option Blankcheck before Erase. 

Blankcheck before Erase can be set to off or on. Note 1

on: Blank check is executed before execution of the Erase and EPV 
commands. If the result of the blank check is OK, erasure processing is
not executed. 

off: Blank check is not executed before execution of the Erase and EPV 
commands. 

VRF after PRG Displays the status of the command option Verify after Program. Verify after

Program can be set to off or on. Note 1

on: After execution of the Program and EPV commands, data is verified
against written data to the flash memory. 

off: After execution of the Program and EPV commands data is not verified
against written data to the flash memory. 

SCF after PRG Displays the status of the command option Security Flag after Program. 

Security Flag after Program can be set to off or on. Note 1

on: After execution of the Program and EPV commands, the security flag
selected by Security flag settings is automatically set. 

off: After execution of the Program and EPV commands, the security flag
selected by Security flag settings is not set. 

SUM after PRG Displays the status of the command option Checksum after Program. 

Checksum after Program can be set to off or on. Note 1

on: After execution of the Program and EPV commands, the flash memory
checksum value of the target device is read from the target device and 
displayed on the message display. 

off: After execution of the Program and EPV commands, the flash memory
checksum value of the target device is neither read nor displayed on the
message display.

Prog Area Prog Area shows if multiple program areas are supported for the target device
connected to PG-FP4. If multiple program areas are supported, the current
selection (0 or 1) will be displayed.
on (0): User program Area 0 (0x00000000 – 0x000FFFFF)
on (1): User program Area 1 (0x00100000 – 0x001FFFFF)
off: Entire 2 MB user program area is selected.

Chip ERS dis. Displays the status of Disable Chip Erase of Security settings. Chip Erase 

Disabled can be set to on or off. Notes 1, 2

on: Block Erase and Chip Erase commands are disabled
off: The Chip Erase command is enabled.

Notes: 1. This command is not supported in all flash devices.

2. This command sets options, which become active as soon as the security flag is set in the
device.
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Notes: 1. This command is not supported in all flash devices

2. This command sets options, which become active as soon as the security flag is been set in
the device.

Block ERS dis. Displays the status of Disable Block Erase of Security settings. Block Erase

Disable can be set to on or off. Notes 1, 2

on: The Block Erase command is disabled.
off: The Block Erase command is enabled. 

PRG disable Displays the status of Disable Program of Security settings. Disable Program

can be set to on or off. Notes 1, 2

on: Program and Block Erase commands are disabled.
off: The Program command is enabled.

READ disable Displays the status of Disable Read of Security settings. Disable Read can be

set to on or off. Notes 1, 2

on: The Read command is disabled.
off: The Read command is enabled.

Boot Blk PRG dis Displays the status of Disable Boot Block Programming of Security settings.

Disable Boot Block Programming can be set to on or off. Notes 1, 2

on: Chip Erase command is disabled, Program and Block Erase commands
are disabled for all blocks, which are part of the Boot block cluster.

off: No restrictions for the Boot block cluster.

Reset Vector Displays the address, where program execution starts after Reset.

End Boot Blk Displays the last (highest) block of the Boot block cluster.
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6.1.4 Voltage Setting menu

The settings of the voltage setting menu cannot be changed in stand-alone operation mode. All values
shown have been extracted from the parameter file downloaded during a previous programming 
session.

Vdd Vdd displays the VDD value used for the target device connected to PG-FP4.

Vdd2 Vdd2 displays the VDD2 value used for the target device connected to PG-FP4.

Vdd Source Vdd Source displays the source of VDD. VDD may be provided from PG-FP4 or
the target hardware.

Clk Level Clock Level indicates the voltage level of the serial communication signal. High
level of the serial communication signal may be set to VDD or VDD2.

Ser Level Serial Level indicates the voltage level of the serial communication signal. High
level of the serial communication signal may be set to VDD or VDD2.

Res Level Reset Level indicates the voltage level of the reset signal. High level of the reset
signal may be set to VDD or VDD2.

HS Level HS Level indicates the voltage level of the handshake signal. High level of the
handshake signal may be set to VDD or VDD2.

Vpp Vpp indicates the VPP value used for the device connected to PG-FP4.
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6.1.5 Utility/Misc. menu

Reset FP4 > Reset FP4 resets the programmer.

FP4 F/W Version PG F/W Version shows the firmware version number of PG-FP4.

PRM Name PRM Name displays the file name of the downloaded parameter file.

PRM File Version PRM File Version displays the version number of the PRM file downloaded to
PG-FP4.

HEX File Name HEX File Name displays the file name of the HEX or SREC file downloaded into
PG-FP4.
If two prog areas are available, this menu shows the file name of the currently
selected area.

CRC Sum (FP4) CRC Sum (FP4) displays the checksum, generated by FP4 through 
GUI File – Checksum menu. See chapter 4.4.1 for details.
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6.2 PG-FP4 remote control mode

The PG-FP4 can be used in remote control mode. In order to enable this mode, the extension 
connector must have been switch from centronics mode to remote control mode using the ctr off R 
command. The selected mode is stored in PG-FP4’s EEPROM and can be used during stand-alone
operation.

6.2.1 PG-FP4 extension connector

Figure 6-2: PG-FP4 extension connector and signals

Table 6-1: PG-FP4 extension connector and signals 

All signals in remote control mode are active high. The signal I/O is TTL level (74ABT241, see chapter
“User system interface circuits”).

Pin 
number

Remote control 
mode

Operation

2 Start EPV 0 In
A high signal starts Erase-Program-Verify sequence of progarea 0.
If progarea is disabled, this signal starts Erase-Program-Verify
sequence of the complete PG-FP4 memory area.

3 Start EPV 1 In
A high signal starts Erase-Program-Verify sequence of progarea 1.
If progarea is disabled, this signal will be ignored.

6 Connected Out
A high signal indicates that connection to the target device has
been established.

7 Busy Out A high signal indicates that an operation is ongoing.

8 OK Out
A high signal indicates that the previous operation has been 
completed successfully.

9 Error Out
A high signal indicates that the previous operation has not been
completed successfully.
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After unpacking PG-FP4 please connect PG-FP4’s ‘Serial Host’ connector to your host computer using
the provided serial interface cable.
Start communication with PG-FP4 using 9600 bps, 8 data bits, 1 stop bit no parity and hardware 
handshake enabled. Once communication is established you may switch to 19200 bps, 38400 bps,
57600 bps or 115200 bps. Make sure that communication is done in lower case letters only.
After plugging in the power supply the host screen will show the standard output of PG-FP4 showing
the firmware version numbers. The status LED is switched off because no connection to any device has
been established so far. The LCD display on PG-FP4 shows ‘Commands   >’ indicating that PG-FP4 is
ready for operation.

Figure 7-1: Initial information screen of PG-FP4

Following steps are necessary to connect a device to PG-FP4 and program it:

• The device has to be connected physically to PG-FP4 using the correct NEC flash programming 
adapter (FA-XXX-YY, FA-XXXYY-ZZZ(-A)) and the provided target cable. 

• Download a standard parameter file (PRM file) and optional a user defined setting file (SET file). 
PG-FP4 will store all parameters in its internal EEPROM and continue to use those until a new 
parameter file download overwrites them.

• In order to use the parallel download feature, enter ctr on R and use the lod command to 
download the application program file. As soon as PG-FP4 responds with the “now loading” 
message, open a DOS command shell and enter:

COPY <file name> LPTn R n: parallel port number
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For a brief description of available commands, enter hlp R in the communication window.

Figure 7-2: PG-FP4 help information
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7.1 PG-FP4 Control Commands

PG-FP4 control commands are used to prepare PG-FP4 for flash programming, such as parameter 
setting, up- and download of application programs and firmware update. Control commands do not
require connection to a flash device.

7.1.1 downprm / downset command

The downprm / downset commands prepare PG-FP4 to load a standard flash parameter file or user
flash parameter file respectively via serial communication line. The parameters configure PG-FP4 for
programming a connected flash device. All parameters are stored in the PG-FP4 internal EEPROM
area so that they will be available also during power off and may be used at later times again.

After the downprm / downset command has been entered, the terminal program must send a 
standard flash parameter file (*.PRM) or user defined flash parameter file (*.SET) in ASCII format to
PG-FP4. Select the corresponding Send File menu from your terminal program and select the 
PRM file / SET file you want to send to PG-FP4.

Indicators during download sequence:

Indicators after completion of download sequence:

Indicators after downprm in case of download error:

Command Description Screen Output

downprm R Prepares PG-FP4 to load a standard 
flash parameter file

Now loading...

downset R Prepares PG-FP4 to load a user 
defined flash parameter file

Now loading...

Status LED Message Display Screen Output

**** BUSY **** ...

Status LED Message Display Screen Output

Commands > OK

Status LED Message Display Screen Output (Area mode)

No error message. See screen output. ERROR: <text>
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7.1.2 upprm / upset command

The upprm / upset command prepare PG-FP4 to send a standard flash parameter file or user flash 
parameter file respectively via serial communication line. The parameters will be read from the PG-FP4
internal EEPROM area.

After the upprm / upset command has been entered, the terminal program must accept the 
requested data to store it in an ASCII file. Activate the corresponding Capture or Log menu from your
terminal program to save the data sent by PG-FP4. As soon as the preparation of the terminal program
has been completed, any keystroke sent to PG-FP4 will start the upload sequence. 
After the upprm / upset commands have been entered, the terminal program should save the 
standard flash parameter data in an ASCII file with the extension *.PRM and the user defined flash
parameter file in a file with the extension *.SET.

Indicators during upload sequence:

Indicators after completion of upload sequence:

Command Description Screen Output

upprm R Prepares PG-FP4 to send a 
standard flash parameter file

Start output with any key.

upset R Prepares PG-FP4 to send a user 
defined flash parameter file

Start output with any key.

Status LED Message Display Screen Output

**** BUSY **** <Parameter file contents>

Status LED Message Display Screen Output

Commands > OK
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7.1.3 lod command

The lod command prepares PG-FP4 to load an application program via serial or parallel communica-
tion line (see also ctr command). Depending on the program area selection, the download program will
be stored in the PG-FP4 internal flash memory area 0 or flash memory area 1. 
In addition to the file itself the name of the download file can be stored in PG-FP4 also.
Using the lod command without parameter the selected program memory area will be erased before the
target program is loaded.
Both file formats are accepted, Intel HEX file format and Motorola S-Record file format.

After the lod command has been entered, the terminal program must send the requested application
program file in ASCII format to PG-FP4. Select the corresponding Send File menu from your terminal
program and select the target program file you want to send to PG-FP4.

PG-FP4 detects the end of the download sequence automatically by interpreting the download file 
format. As soon as the corresponding end record has been detected, the download sequence is 
complete.

Indicators during download sequence:

PG-FP4 indicates download completion by displaying the address range detected.

Indicators after completion of download sequence:

Command Description Screen Output

lod R Prepares PG-FP4 to load a target 
program file

Erasing external Flash...
Now loading...

lod add R Prepares PG-FP4 to load a target 
program file in addition to any 
loaded program

Now loading...

lod fname=filename R Prepares PG-FP4 to load a file name.
filename may have up to 16 
characters incl. extension.

Now loading...

Status LED Message Display Screen Output

**** BUSY **** ...

Status LED Message Display Screen Output

Commands > Address range: 0xssssss to
0xeeeeee
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7.1.4 hex / srec command

The hex and srec commands prepare PG-FP4 to send memory data contents via serial 
communication line in Intel HEX file format or Motorola S-Record file format respectively. Depending on
the program area selection, the data will be read from the PG-FP4 internal flash memory area 0 or flash
memory area 1. 

After the hex / srec command has been entered, the terminal program must accept the requested
data to store it in an ASCII file. Activate the corresponding Capture or Log menu from your terminal 
program to save the data sent by PG-FP4. As soon as the preparation of the terminal program has
been completed, any keystroke sent to PG-FP4 will start the upload sequence.

Indicators during upload sequence:

Indicators after completion of upload sequence:

Command Description Screen Output

hex ss nn R Prepares PG-FP4 to send data in 
Intel HEX file format

ss memory start address
nn number of bytes to send

Start output with any key.

srec ss nn R Prepares PG-FP4 to send data 
in Motorola S-Record file format

ss memory start address
nn number of bytes to send

ss, nn are accepted in 
hexadecimal format.

Start output with any key.

Status LED Message Display Screen Output

**** BUSY **** <Update data in Intel HEX 
or Motorola S-REC format>

Status LED Message Display Screen Output

Commands > (none)
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7.1.5 fname command

The fname command shows the name of the HEX file or SREC file downloaded to PG-FP4.
The file name has been set as parameter to the lod command. 

If prog area is enabled for the current device, file names for both prog areas are shown, if available.

If there is no file name to be shown, 'n.a.' will be displayed. 
An asterix '*' marks the currently selected programming area, if enabled.

7.1.6 brt command

The brt command changes the serial communication speed between PG-FP4 and the terminal 
program.

Once the communication speed of PG-FP4 has changed you have to change the communication speed
of your terminal program as well. Please make sure that you disconnect your terminal program after
communication speed has changed and reconnect again to make the new settings valid for the 
communication session. 

Command Description Screen Output

fname R Displays name of downloaded HEX file
or SREC file.

File name = <file name>

Command Description Screen Output

fname R Displays name of downloaded HEX file
or SREC file.

File name [0*] = <file name 1>
File name [1] = <file name 2>

Command Description Screen Output

brt R Displays current communication speed 
setting

Current Baudrate is:
xxxxx

brt 9600 R Sets communication speed to 9600 bps New Baudrate is: 9600

brt 19200 R Sets communication speed to 19200 bps New Baudrate is: 19200

brt 38400 R Sets communication speed to 38400 bps New Baudrate is: 38400

brt 57600 R Sets communication speed to 57600 bps New Baudrate is: 57600

brt 115200 R Sets communication speed to 115200 bps New Baudrate is: 115200
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7.1.7 ctr command

The ctr command allows to configure the extension connector as centronics input port for parallel
download or as control port for remote control.

For detailed information about remote control signals, please refer to chapter “Connectors and Cables”.

7.1.8 crc command

The crc command calculates and reports a CRC checksum of the selected programming area.

Note: The parameter startaddress is based on the physical start address of the selected programming
area.

Command Description Screen Output

ctr R Displays current port setting Parallel port in xxxx mode

ctr on R Configure port as centronics port Parallel port in centronics mode

ctr off R Configure port as remote control 
port

Parallel port in remote control
mode

Command Description Screen Output

crc R Calculates CRC checksum of the 
selected programming area.

Checksum: ss - ee = CCCCCCCC

crc nn R Calculates the CRC checksum of 
the selected memory area.
nn: number of bytes

Checksum: ss - ee = CCCCCCCC

crc ss nn R Calculates the CRC checksum of 
the selected memory area.
ss: start address
nn: number of bytes

ss, nn are accepted in hexadecimal 
format.

Checksum: ss - ee = CCCCCCCC
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The CRC32 checksum calculation program source code is given below:

#define POLYNOMIAL 0x04c11db7L

static unsigned long crc_table[256];

void gen_crc_table()
/* generate the table of CRC remainders for all possible bytes */
{

register int i, j; register unsigned long crc_accum;

for (i = 0; i < 256; i++) {

crc_accum = ((unsigned long) i << 24);

for (j = 0; j < 8; j++) {

if (crc_accum & 0x80000000L)
                   crc_accum = (crc_accum << 1) ^ POLYNOMIAL;
                else
                   crc_accum = (crc_accum << 1);}

         crc_table[i] = crc_accum; 
}
return; 

}

unsigned long update_crc(unsigned long crc_accum, char *data_blk_ptr, int 
data_blk_size)
{
/* update the CRC on the data block one byte at a time */

register int i, j;

   for (j = 0; j < data_blk_size; j++) {
i = ((int) (crc_accum >> 24) ^ *data_blk_ptr++) & 0xff;

        crc_accum = (crc_accum << 8) ^ crc_table[i]; 
}
return crc_accum; 

}

void main(void)
{

unsigned long init_crc = 0xFFFFFFFFL;
unsigned long crc;

unsigned char *data_ptr;
int data_size;

gen_crc_table();

crc = update_crc (init_crc, data_ptr, data_size);
}
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7.1.9 acs command

The acs command calculates and reports an arithmetic checksum of the selected programming area.

Calculation method: acs = (1 + ((Sum of all bytes) xor 0xFFFF)) & 0xFFFF

Note: The parameter startaddress is based on the physical start address of the selected programming
area.

7.1.10 fill command

The fill command fills the currently selected programming area memory space or a subset of it with
a predefined or user defined byte pattern. 
The complete memory area will be erased before the fill command fills the selected memory area with
the required byte pattern.

Command Description Screen Output

acs Calculates arithmetic checksum 
of the selected programming area.

Checksum: ss - ee = CCCC

acs nn Calculates arithmetic checksum 
of the selected programming area.
nn: number of bytes

Checksum: ss - ee = CCCC

acs ss nn Calculates arithmetic checksum 
of the selected programming area.
ss: start address
nn: number of bytes

ss, nn are accepted in hexadecimal
format.

Checksum: ss - ee = CCCC

Command Description Screen Output

fill a R Fills the complete programming 
area with 0xFF

Erasing external Flash....OK

fill ss nn xx R Fills (parts of) the programming 
area with a user defined byte 
pattern.
ss: start address
nn: number of bytes to fill
xx: byte pattern to fill in

ss, nn, xx are accepted in 
hexadecimal format.

Erasing external Flash...OK
Filling memory...OK
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7.1.11 ver command

The ver command displays the version number of the firmware program and bootloader program of
PG-FP4.

7.1.12 res command

The res command resets PG-FP4 to its initial state (power-on reset). PG-FP4 will read communication
and programming parameters from its internal EEPROM and will use them.

Command Description Screen Output

ver R Displays bootloader and firmware 
version of PG-FP4.

Bootloader Version Vx.yy
Firmware Version Vx.yy

Command Description Screen Output

res R Resets PG-FP4. Start-up screen (see Fig. 7-1)
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7.1.13 progarea command

The progarea command allows selecting one out of the two available flash memory areas inside 
PG-FP4 for target program storage. 

Depending on the size of FP4’s flash memory, the address ranges used for progarea 0 and progarea 1
may vary.

In case of 2 MB internal flash memory:

progarea 0: 0x00000000 to 0x000FFFFF (1 MB)
progarea 1: 0x00100000 to 0x001FFFFF (1 MB)
No progarea: 0x00000000 to 0x001FFFFF (2 MB)

In case of 4 MB internal flash memory:

progarea 0: 0x00000000 to 0x001FFFFF (2 MB)
progarea 1: 0x00200000 to 0x003FFFFF (2 MB)
No progarea: 0x00000000 to 0x003FFFFF (4 MB)

If support for multiple programming areas is not supported according to parameter file setting, the 
message Program Area usage disabled is shown.

Command Description Screen Output

progarea R Displays current progarea setting Active Program Area: n
Max. program size: 2 MBytes

progarea 0 R Activates program area 0 Active Program Area: 0

progarea 1 R Activates program area 1 Active Program Area: 1
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7.1.14 version_up command

The version_up command allows upgrading the PG-FP4 internal bootloader and firmware. PG-FP4
is equipped with a self-programming mechanism so that downloading the new firmware program to 
PG-FP4 and starting the update procedure are supported.
Before version_up command is executed, make sure that the firmware update program file is 
available on your PC. Please, check the NEC WEB page(s) at http://www.eu.necel.com/update and
download the necessary software update packages.
A typical name of the firmware program file is PG-FP4_VUP_xxxx.REC, where xxxx is the version
number of this firmware.

To start firmware update, enter the version update command:

version_up R

PG-FP4 asks for user confirmation before starting the update sequence:

Are you sure you want to update bootloader and firmware (y/n)?

Enter y to continue. PG-FP4 displays: 

Erasing external Flash...OK

Now loading Firmware...

At this stage, PG-FP4 waits to receive the new firmware in S-Record format. From your terminal 
program, select SEND ASCII FILE menu and browse for the new firmware data file you downloaded
from the NEC WEB site. Once the file is downloaded, PG-FP4 displays information about processing:

     **** CAUTION ****

Now bootloader and firmware will be programmed.

Please ensure that:

 - the correct bootloader file has been downloaded

 - the power is NOT disconnected during this operation

 - the programmer is NOT reset during this operation

Do you want to continue (y/n)?

Enter y to continue. PG-FP4 displays:

Selfprogramming Area(s): 0,1 (Bootloader + Firmware)

Copy Selfprog Library into RAM... OK.

Checking Vpp...OK.

Performing blank check...

not blank, performing erase... OK.

Programming the device................................... OK.

Doing verify...

Performing blank check...

not blank, performing erase... OK.

Programming the device................................... OK.

Doing verify... OK.

Programming successful. Restarting PG-FP4.

PG-FP4 will restart and the new firmware version number will be shown on the initial screen.
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7.2 PG-FP4 Device Commands

PG-FP4 device commands interact with the target flash device in the NEC flash programming adapter
connected to PG-FP4. The connection to a flash target device is established automatically.

7.2.1 bln command

The bln command performs a blank check of a target flash device and reports the resulting target
device status.

Caution: The bln command is not supported for all flash devices!

Depending on the blank check mode of the target device (chip mode or area mode), message display
and screen output will differ. Indicators while blank checking in chip mode:

Indicators while blank checking in area mode:

Indicators after blank check execution of a blank device:

Indicators after blank check execution (area mode) of a non-blank device:

Command Description

bln R Performs a blank check of the flash device.

Status LED Message Display Screen Output (chip mode)

Blank check Chip 
... 

Blank check Chip: OK

Status LED Message Display Screen Output (area mode)

Blank check Area 
N..... 

Blank check Area 000: OK
Blank check Area 001: OK
...
Blank check Area NNN: OK

Status LED Message Display Screen Output

Command > Blank check OK

Status LED Message Display Screen Output (Area mode)

Error: 051
Blank chk failed

Blank check Area NNN: ERROR
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Indicators after blank check execution (chip mode) of a non-blank device:

7.2.2 ers command

The ers command erases a target flash device.

Depending on the programming mode of the target device (complete chip or selected area only), 
message display and screen output will differ. Indicators while programming in chip mode:

If the target device is already erased, the erase procedure will not start:

Indicators while programming in area mode:

Status LED Message Display Screen Output (Chip mode)

Error: 051
Blank chk failed

Blank check Chip: ERROR

Command Description

ers R Erases the flash device.

Status LED Message Display Screen Output (Chip mode)

Blank check chip
..... 
Prewrite: Chip
N..... 
Erase:      Chip
..... 

Blank check Chip: Not blank,
Erase needed.
Prewrite Chip: OK
Erase Chip: 

Status LED Message Display Screen Output (Chip mode)

Blank check Chip
.....

Blank check Chip: OK, 
Erase skipped.

Status LED Message Display Screen Output (Area mode)

Blank check Area
N..... 
Prewrite: Area
N..... 
Erase:      Area N 

Blank check Area 000: 
Not blank, Erase needed.
Prewrite Area NNN: OK
Erase Area NNN: 

Writeback Writeback OK Command depends
on the device status
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If the target device is already erased, the erase procedure will not start:

Indicators after successful erase:

Indicators after non-successful erase:

Status LED Message Display Screen Output (Area mode)

Blank check Area
N.....

Blank check Area 000: OK, 
Erase skipped.

Status LED Message Display Screen Output

Commands > Erase OK

Status LED Message Display Screen Output

Error: 41
Erase failed

ERROR
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7.2.3 prg command

The prg command programmes a target flash device.

Depending on the programming mode of the target device (complete chip or selected area only), 
message display and screen output will differ. Indicators while programming in chip mode:

Indicators while programming a selected memory area:

Command Description

prg R Programs the selected memory area of PG-FP4 into the target device.

Status LED Message Display Screen Output (chip mode)

Write Chip
Addr: 0xnnnnnn

Verify Chip
Internal

Write Chip: 
10%
20%
...
100%
OK
Internal Verify Chip: OK
Verify OK

Addr: 0xnnnnnn Verify chip:
10%
20%
...
100%
Verify OK

If Read verify after
program is enabled

Status LED Message Display Screen Output (memory area mode)

Write Selective
Addr: 0xnnnnnn

Verify Chip
Internal

Write ssssssss to eeeeeeee: 
10%
20%
...
100%
OK
Internal Verify Chip: OK
Verify OK

Addr: 0xnnnnnn Verify chip:
10%
20%
...
100%
Verify OK

If Read verify after
program is enabled
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Indicators while programming a selected flash area:

Indicators after successful verification:

Indicators after non successful verification:

Status LED Message Display Screen Output (flash block mode)

Write Selective
Addr: 0xnnnnnn

Verify Chip
Internal

Write Area NNN: 
10%
20%
...
100%
OK
Internal Verify Area NNN: OK
Verify OK

Addr: 0xnnnnnn Verify Area NNN:
10%
20%
...
100%
Verify OK

If Read verify after
program is enabled

Status LED Message Display Screen Output

Commands > Write OK

Status LED Message Display Screen Output

Error: 081
Verify failed

ERROR
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7.2.4 vrf command

The vrf command verifies the flash device’s memory against the memory contents of PG-FP4.

Depending on verify mode of the target device (chip mode or area mode), message display and screen
output will differ. Indicators while verifying in chip mode:

Indicators while verifying in area mode:

Indicators after successful verification:

Indicators after non successful verification:

Command Description

vrf R Performs a verification of the target device’s memory against the memory contents
of PG-FP4.

Status LED Message Display Screen Output (chip mode)

Verify Chip 
Addr:...

Verify Chip: 
10%
20%
...
100%

Status LED Message Display Screen Output (area mode)

Verify Area N
Addr:...

Verify Area 000: 
10%
20%
...
100%

Status LED Message Display Screen Output

Commands > Verify OK

Status LED Message Display Screen Output

Error: 081
Verify failed

ERROR
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7.2.5 read command

The read command is used to read out the flash contents of the target device.

Indicators while reading data:

In case of any error, the status LED will show a red signal. Please follow the recommendations given on
the screen and check the error number in the message display.

7.2.6 epv command

The epv command performs an erase, program and verify of a target flash device.

The epv command output to screen and messages are the same messages sent for connect, blank
check, erase, program and verify.

Note: The verify command will only be executed as part of the epv command if Read verify after
program is enabled. See Advanced setup section.

Command Description

read R
read ss ee R

Read out flash memory of target device, and show data in hexadecimal
form. Optional parameters ss and ee specify start and end address. ss and
ee must be multiples of 0x100.

read hex R
read hex ss ee R

Read out flash memory of target device, and print data in Intel HEX file for-
mat. Optional parameters ss and ee specify start and end address. ss and
ee must be multiples of 0x100.

read srec R
read srec ss ee R

Read out flash memory of target device, and print data in Motorola S-record
file format. Optional parameters ss and ee specify start and end address. ss
and ee must be multiples of 0x100.

Status LED Message Display Screen Output

Read Read 000000 to 03FFFF:
Press <return> to start/continue output.
000000: 00 00 00 00 00 00 00 00...
000010: 00 00 00 00 00 00 00 00...
000020: BA 05 80 07 30 8A 81 07...
000030: BA 05 80 07 FA 02 81 07...
000040: BA 05 80 07 EA 02 81 07...
...

Command Description

epv R Connects PG-FP4 to the target flash device and starts the blank check, erase, 
program and verify command sequence.
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7.2.7 sig command

The sig command reads the signature from a target flash device.

Indicators while signature reading:

Indicators after reading signature successfully:

In case of any error, the status LED will show a red signal. Please follow the recommendations given on
screen and check the error number in the message display. 

7.2.8 sum command

The sum commands reads the checksum calculated inside the target device and displays it.

Caution: The sum command is not supported for all flash devices!

Command Description

sig R Reads the target device signature and device specific memory information.

Status LED Message Display Screen Output

Signature: Device name: Dxxxxxxx
Device data: xx xx xx
Device end addr: eeeeeeee
Address data 000: xxxxxxxx
Address data 001: xxxxxxxx
...
Address data nnn: aaaaaaaa
Area data NNNN: XXXXXXXX

Status LED Message Display Screen Output

Signature:
Dxxxxxxx

OK
Dxxxxxxx>

Command Description Screen Output

sum R Requests checksum calculation inside
the target device.

Checksum: 0xCCCC

sum ss nn R Calculates a checksum of the memory
area starting at ss and covering nn
bytes of the device.
ss: start address
nn: number of bytes

Checksum: 0xCCCC
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7.2.9 scf command

The scf command sets the security flags in the target device.The security flags are specified in the
SET file and may be modified in the GUI advanced setup dialog.

Caution: The scf command is not supported for all flash devices!

Command Description Screen Output

scf R Sets the security flags in the target
device.

OK
120 User’s Manual U15260EE3V1UM00
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Using Terminal Communication Program

As an example, a V850/SB1 micro-controller will be used to show a typical programming sequence
using the Windows HyperTerminal software.

1. Use the provided serial cable to connect PG-FP4 to your host computer.

2. Use the target cable to connect PG-FP4 to the target hardware. This may either be the NEC 
FA-100GC programming adapter or your own target hardware.

3. Select the suitable AC-plug (EURO, UK or US/JAPAN) and connect it to the AC adapter.

4. Use the AC adapter to connect it to PG-FP4 and mains. The status LED of PG-FP4 should be off
and the LCD display shows ‘Commands   >’ indicating that PG-FP4 is ready for operation.

5. If not yet done, copy the flash parameter file for V850/SB1 to your hard disk and install it into 
<PG-FP4 install path>\PRM. You may obtain it from the NEC internet site 
http://www.eu.necel.com/update. 
Make sure that you download the flash parameter files according to your device specification 
(version number, mask rank, etc.).

6. Start HyperTerminal. 

7. Activate File → Properties menu to set the appropriate port number you connected PG-FP4 to. 

Figure 8-1: HyperTerminal properties window
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By pressing Configure… you proceed to the communication settings for the selected port.

Figure 8-2: Hyperterminal Port Setup

The communication speed shall be set to 9600 bps. Select 8 data bits, no parity, 1 stop bit and
hardware flow control in this window. Press OK to close this dialog.
If any other communication speed has been selected in a previous programming session, PG-FP4
will continue to use this. The terminal program’s communication speed must be adjusted in this
case.

8. Select Call → Disconnect and Call → Connect menus to activate the communication settings
made in step 7. You will now be connected to the PG-FP4.
If you would like to change the communication speed you may use the brt command in the
HyperTerminal communication window to select any other speed setting. Then return to step 7 to
adjust the HyperTerminal settings.

Note: For communication speed higher than 19200 baud it is recommended to use another terminal,
i.e. Tera TermPro. 
It can be downloaded freely from the WEB. Please, search for the keyword teraterm to find the
download page.

9. Type downprm in the Hyperterminal communication window, activate Transfer → Send Text File
menu. Select the V850/SB1 flash parameter file from the directory you have chosen in step 5.
Press Open to send this file to PG-FP4.
As soon as the download is complete, PG-FP4 is prepared to program V850/SB1 devices 
according to the settings in the parameter file.
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10. Define the destination memory area for your target program in PG-FP4 by one of the following
commands, provided the PRM and SET parameter files allow this setting:

progarea 0 R Program area 0 will hold the target program
or

progarea 1 R Program area 1 will hold the target program

11. Start downloading your program by using the 

lod R 

command. When Now loading is displayed on the screen, select Transfer → Send Text File in
HyperTerminal. Highlight the file to be send and press Open. While downloading is processed,
several ‘.’ will be displayed. 

12. Use the 

epv R

command to connect PG-FP4 to the target device and program the application program into the
device’s flash memory. 

13. If necessary, insert another device to be programmed into the programming adapter and repeat
step 12.

14. If no other device needs to be programmed exit HyperTerminal. All settings made during this 
programming session will be saved in the PG-FP4 so that they can be reused next time.
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Chapter 9 Connectors and Cables

9.1 Operating and storage environment

The PG-FP4 operating and storage requirements are given in the table below.

Table 9-1: Operating and storage environment 

9.2 Power supply connector

The power supply connector is located on the right side of PG-FP4.

Figure 9-1: Power supply connector

Figure 9-2: Pinout power supply connector

The specification of the power supply is:

AC input range: 100 V to 240 V, 47 Hz to 63 Hz
DC output: 15 V
Current consumption: 0.8 A max.

Caution: Connect only the provided AC adapter to the power supply jack of PG-FP4!

Item Specification

Operating Environment Temperature: 0°C to +40°C 
Humidity: 35% to 85% (without condensation)

Storage Environment Temperature: -5°C to +45°C 
Humidity: 10% to 90% (without condensation)

+ _
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9.3 D-SUB 9 host connector

The host connector is located on the right side of PG-FP4.

Figure 9-3: D-SUB 9 host connector

Figure 9-4: Pinout D-SUB 9 host connector

Table 9-2: Pinout of D-SUB 9 host connector 

The D-SUB 9 host connector is provided by Provertha.

Serial Host D-SUB 9 Signal name at PG-FP4

1 NC

2 RxD

3 TxD

4 NC

5 VSS

6 NC

7 RTS

8 CTS

9 NC

1 5

96
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9.3.1 RS-232 cable (crossed)

The host cable is a standard shielded RS-232 cable of 2 meter to maximum 3 meter length. The 
connectors on both sides are D-SUB 9-pin female. The connections look as follows:

Figure 9-5: Host cable connections

1
2
3
4
5
6
7
8
9

1
2
3
4
5
6
7
8
9
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9.4 HD-SUB 15 target device connector

The target device connector is located on the right side of PG-FP4.

Figure 9-6: HD-SUB 15 target device connector

Figure 9-7: Pinout HD-SUB 15 target device connector

Table 9-3: Pinout of HD-SUB 15 target device connector  

The HD-SUB 15 target device connector is provided by Provertha.

PG-FP4 HD-SUB 15 Signal name at PG-FP4

1 SO / TxD

2 SI / RxD

3 SCK

4 RESET

5 VDD2

6 FLMD1

7 H/S

8 VDD

9 VDD

10 NC

11 VPP

12 FLMD0

13 VDE

14 CLK

15 GND

15

10

11

6

15
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9.5 Target cable

The target cable is equipped with two connectors for the NEC programming adapters FA-XXX-YY and
FA-XXXYY-ZZZ(-A).

Figure 9-8: Target cable outline

HD-SUB 15 (male) dual row female connector 10-pin / 16-pin, 0.100" grid

Figure 9-9: Target cable pinout

Table 9-4: Target cable pinout 

Signal HD-SUB 15 16-pin 10-pin

SO / TxD 1 5 5

SI / RxD 2 3 3

SCK 3 7 7

RESET 4 2 2

VDD2 5 11 -

FLMD1 6 12 -

H/S 7 8 8

VDD 8, 9 4 4

NC 10 13 -

VPP 11 6 6

FLMD0 12 14 -

VDE 13 10 10

CLK 14 9 9

GND 15 1 1

1

5

6

11

10

15
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Figure 9-10: Target connectors outline (view from solder side) and pinout

Table 9-5: Target connectors outline (view from solder side) and pinout  

Caution: When using the I2C interface to program a target device, make sure that SI and SO
signals lines are externally short-circuited.

Pin number Signal (16-pin) Pin number Signal (10-pin)

1 GND 1 GND

2 RESET 2 RESET

3 SI/RxD 3 SI/RxD

4 VDD 4 VDD

5 SO/TxD 5 SO/TxD

6 VPP 6 VPP

7 SCK 7 SCK

8 H/S 8 H/S

9 CLK 9 CLK

10 VDE 10 VDE

11 VDD2

12 FLMD1

13 NC

14 FLMD0

15 Not used

16 Not used

1 3 5 7 9 11 13 15
2 4 6 8 10 12 14 16

1 3 5 7 9
2 4 6 8 10
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9.6 Extension connector

The extension connector can be configured as centronics interface or as remote control port. 
Depending on the selection, one of the following signal setting is available.

Figure 9-11: D-SUB 25 extension connector

Figure 9-12: Pinout D-SUB 25 extension connector

113
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Table 9-6: Pinout of D-SUB 25 extension connector 

Caution: (*): Reserved for future use, leave open!

Notes: 1. The D-SUB 25 host connector is provided by Provertha.

2. All output signals are active high.

3. Input signal ‘Cancel Button’ is active low, all others are active high.

4. Input signals ‘Cancel Button’, ‘Next Button’ and ‘Enter Button’ can be used to control FP4.
These signals are evaluated by software; be sure to have latest firmware installed before
trying to use this functionality.

5. Pins 13–17 (Pull-up) tied together can be used to apply high level to an input pin. Only one
of input pins Start EPV, ‘Next Button’ or ‘Enter Button’ can be set to H-level at the same
time, because the Pull-up outputs are connected to VDD via 10 k resistors.

Pin number Signal Centronics mode Remote control mode

1 IO3-0 Strobe In Cancel Button In

2 IO1-0 D0 IO Start EPV 0 In

3 IO1-1 D1 IO Start EPV 1 In

4 IO1-2 D2 IO Next Button In

5 IO1-3 D3 IO Enter Button In

6 IO2-0 D4 IO Connected Out

7 IO2-1 D5 IO Busy Out

8 IO2-2 D6 IO OK Out

9 IO2-3 D7 IO Error Out

10 IO3-2 Ack Out (*) Out

11 IO3-1 Busy Out (*) Out

12 VSS

13 Pull-up

14 Pull-up

15 Pull-up

16 Pull-up

17 Pull-up

18 VSS

19 VSS

20 VSS

21 VSS

22 VSS

23 VSS

24 VSS

25 VSS
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9.7 USB

The USB port connection (Rev. 1.1) allows data transmission up to 12 Mbit/s on an USB type B 
connector.

Figure 9-13: USB port connector
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Chapter 10 Design Proposals for User Systems

This chapter explains the user system design proposals for rewriting the flash ROM in the microcontrol-
ler using PG-FP4.
 

Table 10-1: User system design proposals (1/3)

CPU pin Design proposal

RESET
Do not connect the reset signal generator on the target system to the reset signal of the 
PG-FP4. Otherwise, a signal conflict will occur. To avoid the conflict, isolate the reset signal 
generator from the reset signal of the PG-FP4.
Do not generate RESET while PG-FP4 is connected. Be particularly careful to observe this 
requirement when using a system with an external watchdog timer.

Connect the RESET signal of PG-FP4 at a point where the status of the programmer 
RESET signal and that of the CPU RESET pin are the same.

Correct connection: 

R must be 1 KΩ or more. The value for C must be chosen that the rise 
time between VIL and VIH does not exceed max. spec of the device.

Avoid the following RESET signal connection:
• Connection to a point where the target CPU RESET rise time is slower than the PG-FP4 

RESET rise time.

    Incorrect connection: 

It takes time for the CPU RESET pin to go high after the PG-FP4 
RESET level goes from low to high.

CPU

PG-FP4 RESET

RESET

CPU

R

C

PG-FP4 RESET

RESET

A

CPU

OCPG-FP4 RESET

RESET
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CPU pin Design proposal

RESET
• Connection to a point where the target CPU RESET pin cannot be driven to low level by 

PG-FP4 RESET signal.

     Incorrect connection: 

When the PG-FP4 RESET is driven low, the level of the voltage 
at point A does not fall.

Serial
interface 
pin

While the PG-FP4 is connected, all those ports that are not being used by the PG-FP4 will
be in the input (floating) state. When an external device connected to such a port does not
allow the port to enter the floating state, pull the port up or down.
When the CPU port used by the PG-FP4 is also connected to the input of an external device,
and if that device malfunctions, disconnect the external device.

Example: 

While the CPU port used by the PG-FP4 is also connected to the output of an external
device, and if a sign all collision occurs, disconnect the external device.

Example: 

Table 10-1: User system design proposals (2/3)

A

CPU

PG-FP4 RESET

RESET

Adverse effect

PG-FP4
connector

Input

External device

CPU

SO/TxD

PG-FP4
connector

Collision

Output

External device

CPU

SI/RxD
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CPU pin Design proposal

VPP Keep the wiring between the PG-FP4 connector and the CPU VPP pin as thick and as short
as possible.
Insert neither capacitors nor resistors into the VPP line.

Incorrect circuit: 

Others For the unused pins, refer to the user’s manual of the device.
Some devices have pins that must be processed differently. For these pins also, refer to the
user’s manual of the device.

Example of pins processed differently:
MODE
CKSEL
REGOUT
REGIN, etc.

Table 10-1: User system design proposals (3/3)

CPU

CPU

VPP

VPP

PG-FP4 VPP

PG-FP4 VPP
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Chapter 11 User System Interface Circuits

This chapter describes the user system interface circuits of the PG-FP4.

11.1 SO/TxD, SCK, RESET

11.1.1 VDD / VDD2 supplied by PG-FP4

For programming flash devices, VDD and VDD2 may be supplied by PG-FP4. The signal lines SO/TxD,
SCK and RESET will have TTL level voltage.

Figure 11-1: PG-FP4 output signal level 1

Target System

V Vor

Signal
33 Ω

1 K Ω
74LV125

PG-FP4

DD DD2

VDD

VDD2
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11.1.2 VDD / VDD2 supplied by User System

Alternatively, VDD and VDD2 may be supplied by the User System. The PG-FP4 internal voltage 
regulator is protected so that user VDD / VDD2 will only affect the signal lines SO/TxD, SCK and RESET. 

Figure 11-2: PG-FP4 output signal level 2

11.2 SI/RxD, HS

The SI/RxD and HS input signal must not exceed TTL level voltage.

Figure 11-3: PG-FP4 input signal level 3

Target System

V Vor

Signal
33 Ω

1 K Ω
74LV125

PG-FP4

DD DD2

VDD

VDD2

Target System

Signal
33 Ω

74LV125

PG-FP4

74LV125

100 K Ω

VDD

VDD2
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11.3 CLK

Figure 11-4: PG-FP4 output signal level 4

11.4 FLMD0, FLMD1

Figure 11-5: PG-FP4 output signal level 5

Target System

Signal

150 Ω
74LV125

PG-FP4

74LV125
150 Ω

VDD

VDD2

Target System

Signal
33 Ω

74LV125

PG-FP4

74LV125

VDD

VDD2
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11.5 Extension Connector

The extension connector input signals must not exceed TTL level voltage.

Figure 11-6: PG-FP4 extension connector signal level

The input signals in remote control mode are active low; the output signals are active high. 

User System

Signal

PG-FP4

4.7 KΩ
74ABT241

direction

74ABT241
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Chapter 12 Error Messages

PG-FP4 error and warning messages are displayed on the message display.

12.1 Error messages of PG-FP4 in stand-alone mode

 

Table 12-1: Error messages of PG-FP4 in stand-alone mode (1/2)

No. Message text Error condition Possible workaround

001 Invalid PRM data PRM data is invalid
PRM data file contains invalid data or is incomplete 
or corrupted. Use the original PRM file delivered by 
NEC. Contact NEC support desk else.

002 Not connected No device connected to FP4
Issue a ‘con’ command before the command 
causing this error.

003 Bootstrap Error Bootstrap error

005 Not supported!
The command issued is not supported on the device 
and thus cannot be used.

006 Command aborted! Command aborted

008 Parameter Error! Wrong or illegal Parameter given

009 Power Failure!
A supply voltage failure has 
been detected.

There is possibly a shortcut in the target hardware.

011 Read. Sig. failed Reading device signature failed
Please check if the correct device is selected. If this 
is the case, please contact NEC.

012 Check connection Check connection

FP4 cannot establish connection to the target 
device.
This might be due to wrong connections between 
device and FP4, bad socket contacts or non-working 
oscillator.

013 Addr. Range err Address range error
The address given in the command exceeds the 
device’s address range.

020 Inv. Sig. ID Invalid Signature ID
Please check if the correct device is selected. If this 
is the case, please contact NEC.

021 Inv. Sig. code Invalid Signature code
Please check if the correct device is selected. If this 
is the case, please contact NEC.

022 Inv. Sig. func. Invalid Signature function
Please check if the correct device is selected. If this 
is the case, please contact NEC.

023 Inv. Sig. addr. Invalid Signature address
Please check if the correct device is selected. If this 
is the case, please contact NEC.

024 Inv. device name Invalid device name
Please check if the correct device is selected. If this 
is the case, please contact NEC.

025 Inv. Signature Invalid Signature
Please check if the correct device is selected. If this 
is the case, please contact NEC.

026 Inv Dev/Firm ver
Device or firmware version does 
not match

Try newer PRM file

030 Prewrite Timeout Prewrite timeout
Communication problem between FP4 and the 
target device. Please try the operation again.

032 Prewr. retry err Prewrite retry error

040 Erase Timeout Erase timeout
Communication problem between FP4 and the 
target device. Please try the operation again.

041 Erase failure Erase failure A device defect is most probably causing this error.

042 Ers time exceed Erase time exceed A device defect is most probably causing this error.
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No. Message text Error condition Possible workaround

043 Ers Timeset err Erase timeset error
The parameter file may contain invalid data. Please 
contact NEC.

050 Bln Timeout Blank check timeout
Communication problem between FP4 and the 
target device. Please try the operation again.

051 Blankchk failed Blank check failed
The device connected is not empty. Use the ‘ers’ 
command before programming.

060 Wrb Timeout Writeback timeout
Communication problem between FP4 and the 
target device. Please try the operation again.

061 Writeback failed Writeback failed A device defect is most probably causing this error.

062 Wrb retry exceed Writeback retry exceed A device defect is most probably causing this error.

063 Wrb Timeset err Writeback timeset error
The parameter file may contain invalid data. Please 
contact NEC.

070 Write timeout Write timeout
Communication problem between FP4 and the 
target device. Please try the operation again.

071 Write failed The write operation failed
Either the device was not blank before writing or 
device defect is causing this error.

072 Write retry err Write retry error
Either the device was not blank before writing or 
device defect is causing this error.

073 Wrt. Timeset err Write timeset error
The parameter file may contain invalid data. Please 
contact NEC.

080 Vrf Timeout Verify timeout
Communication problem between FP4 and the 
target device. Please try the operation again.

081 Verify failed Verify failed
The data in the target device’s flash is not the same 
as in FP4.

090 IVrf Timeout Internal verify timeout
Communication problem between FP4 and the 
target device. Please try the operation again.

091 IVerify failed Internal verify failed

Verification for 10 years data retention failed. Please 
program the same device again. If the error still 
occurs, data retention may be less than 10 years for 
this device. 

092 VGT Comm err Device Communication error 
Communication problem between FP4 and the 
target device. Please try the operation again.

093 SUM Comm err Device Communication error
Communication problem between FP4 and the 
target device. Please try the operation again.

094 SCF Comm err Device Communication error
Communication problem between FP4 and the 
target device. Please try the operation again.

095 EXR Comm err Device Communication error
Communication problem between FP4 and the 
target device. Please try the operation again.

096 EXW Comm err Device Communication error
Communication problem between FP4 and the 
target device. Please try the operation again.

099 READ Comm err
Device Communication
error during READ command

Communication problem between FP4 and the 
target device. Please try the operation again.

Table 12-1: Error messages of PG-FP4 in stand-alone mode (2/2)
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12.2 Information messages of PG-FP4 in stand-alone mode

Informational messages do not need any workaround because they do not force an error condition. The
message is send as information only and does not require any user action in response.

12.3 GUI Fatal Error messages

GUI fatal error messages indicate a severe error and GUI operation will not be stable any more. When
the problem persists after restarting the GUI, please contact: fm_support@eu.necel.com.

Table 12-2: Information messages of PG-FP4 in stand-alone mode

No. Message text Description

204 Not connected
The target device was not connected to FP4 when a ‘disconnect’ command was 
issued.

210 Already conn.
A connect command was issued when the target device was already connected to 
FP4.

Table 12-3: GUI Fatal Error messages (1/3)

No. Message text Description

F 100 Could not initialize INI-File.

Errors F 100 to F 899 
indicate a severe internal 
error situations.

F 101 Registering GUI Windows failed.

F 102 Loading GUI Main Menu failed.

F 103 Creating GUI main window failed.

F 104 Loading keyboard shortcuts failed.

F 105 Painting GUI main window failed.

F 106 Starting debug failed.

F 107 Setting status bar text failed.

F 108 Creating tool bar failed.

F 109 Creating Status Bar failed.

F 111 Creating Information Window failed.

F 112 Initialisation of internal GUI status failed.

F 114 Could not initialize dialog boxes.

F 115 Could not initialize window for monitoring communication to the programmer

F 116 Determining program path failed.

F 117 Could not initialize device setup dialog.

F 118 Could not initialize debug information.

F 119 Resizing the Status Bar failed.

F 121 Moving Info Area failed.

F 122 Loading tool tip text failed.

F 123 Setting status bar text failed.

F 124 Loading menu info text failed.
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F 125 Creating CRC check dialog window failed. Errors F 100 to F 128 
indicate a severe internal 
error situations.

F 127 Creating program area selection dialog window failed.

F 128 Stopping debug failed.

F 129 F 129 Close Upload_file_handle failed.
Call close file handle 
function failed

F 200 Invalid start address.

Errors F 200 to F 899 
indicate a severe internal 
error situations.

F 201 Invalid end address.

F 202 Neither Hex nor SREC specified.

F 300 Creating splash screen timer failed.

F 301 Edit control out of space.

F 304 Determining selected download port number failed.

F 406 Terminating receive thread failed.

F 408 Creating status dialog window failed.

F 410 Download failed.

F 411 Connection between host and programmer is broken.

F 412 Communication error.

F 500 Reading current cursor handle failed.

F 501 Unknown result of operation.

F 502 Placing command execution time information in status bar failed.

F 503 Unknown command (status update).

F 504 Unknown command (transmit ended with OK).

F 505 Unknown command (transmit ended with unknown answer).

F 506 Unknown command (receive timeout).

F 507 Unknown command (receive error).

F 508 Unknown command (transmit aborted).

F 600 Please stop logging communication first.

F 601 Opening log file failed.

F 700 USB splash screen timer failed.

F 750 Please stop debugging first.

F 751 Opening debug file failed.

F 752 Debug information overflow. Discharging actual message.

F 753 Setting up message box failed.

F 800 Memory cannot be allocated.

F 801 Shortage of memory.

F 802 Temporary file could not be read. Abort Save File

F 803 File save error. Abort Save File

F 804 error line: <line number>. Data error, abort DATA Check

F 805 error line: <line number>. Data Count error, abort "Data Count" Check

Table 12-3: GUI Fatal Error messages (2/3)

No. Message text Description
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F 806 error line: <line number>. Check sum error, abort "Check sum" Check

Errors F 100 to F 899 
indicate a severe internal 
error situations.

F 807 cannot open Temporary File. Abort "Save File"

F 808 HEX format error.

F 809 Too large address.

F 810 Parameter of "Start Address" is invalid.

F 811 Parameter of "End Address" is invalid.

F 812 File load error. Abort

F 813 Temporary file could not be created. Abort

F 820 Memory allocation error

F 902 Unable to find any PRM file. Please install PRM files.
The GUI does not find any 
PRM file in sub-directory 
\PRM. 

F 903 Invalid character.

F 904 Invalid file format.

F 905 Invalid checksum.

F 906 F 906 Download NWire file failed!
Manage NWire download 
file failed (before calculate 
checksum)

F 907 F 907 Download NWire file failed!
Manage NWire download 
file failed (after calculate 
the checksum)

Table 12-3: GUI Fatal Error messages (3/3)

No. Message text Description
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12.4 GUI Error messages

In addition to the below listed error messages there can be error message displayed as returned from
PG-FP4.

Table 12-4: GUI Error messages (1/3)

No. Message text Description

E 200 Opening script file failed. Opening the specified script file failed. Script file in use?

E 201

E 201 Updating the firmware will take several 
minutes.

ATTENTION:
- The process of updating your firmware
  must NOT be interrupted!
- Without firmware this FP4
  GUI will NOT run properly.

Install new firmware in your programmer?

E 204
Unknown Version of your firmware!
The FP4 GUI may not work properly!

Refer to the Firmware-Update chapter for a description 
of these messages.

E 205
The firmware you are using
requires an update of the GUI!
The FP4 GUI may not work properly!

E 206

E 206
Your firmware is not up to date!
Updating the firmware will take several minutes.

ATTENTION:
- The process of updating your firmware
  must NOT be interrupted!
- Without new firmware this FP4
  GUI will NOT run properly.

Install new firmware in your programmer?

E 207
Wrong firmware in programmer!
The GUI may not work properly!

E 208
The programmer memory does not contain the 
most recent downloaded file (different CRC).
Please download your user application(s) again.

Before issuing an EPV command the GUI verifies 
proper application file contents by verifying actual CRC 
with the one saved after file download in FP4.ini.
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E 209
Searching for a port communicating with the 
programmer failed.
Please check the connection.

No communication with the programmer could be 
established at all. Sequence of connecting FP4 on start 
up of the GUI:
Read most recent INI-file settings. Try opening the most 
recent PC port and send the ver command to the PG.
When 1. failed, the following will be tried 2 times:
Open the USB port and send the ver command 
(on Win 98 and Win 2000 only).
Open COM1 … COM6 with all possible baud rates and 
send the ver command for each of these combinations.
As soon as any of the combinations above succeeds 
the communication port has been found.
When serial communication is established and most 
recently the parallel download port has been used 
(DownloadPort -key in INI-file):
Try opening the parallel PC port and send the ctr on 
command to the PG

E 210 Line too long.
Executing a script file might abort with one of these 
errors. The content of the line, causing the error is also 
displayed. 

E 211 Nested repeat is not supported.

E 212 Loop number invalid.

E 213 File too long.

E 214 Statement 'repeat <num. rep.>' missing.

Executing a script file might abort with one of these 
errors. The content of the line, causing the error is also 
displayed. 

E 215 Command not found

E 216 Download file name missing.

E 217 Opening download file failed.

E 218 Upload file name missing.

E 219 Opening parameter file for upload failed.

E 220 Opening upload file failed.

E 221 Command not allowed in script file.

E 222 Processing a command failed.

E 223 Command execution failed.
The script syntax was correct and the command has 
been send to FP4, but the command execution itself 
showed an error (e.g. verify error on the target device).

E 300 Determining download directory failed.
The selected directory name in the file download dialog 
is invalid.

E 301 Determining upload directory failed.
The selected directory name in the file upload dialog is 
invalid.

E 304 Trying to open serial port failed. Execute command “ver” failed.

E 306 Trying to connect Programmer failed.

E 307 Trying to open USB failed.

E 308 E 308 Create upload file failed. Create upload file failed.

E 309 E 309 Create file failed. Create *.hex or *.rec file failed.

E 316 Trying to connect Programmer failed.

E 317 ver command failed

E 500 Evaluating CRC answer failed.
FP4 answered with an unexpected string after sending 
the Checksum command.

E 501 Operation failed.
Executing a command failed (e.g. verify error signalled 
from target device).

Table 12-4: GUI Error messages (2/3)

No. Message text Description
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E 502 Programmer is not responding. Communication between PC and FP4 timed out.

E 503 Receiving failed. Reading the PC port failed.

E 600
Appending information to communication 
logging file failed.

Writing data to the communication log file failed.

E 800 Illegal address
An end address entered in the hex-editor is below the 
start address.

E 801 The file cannot be read. Processing the selected file in the Hex-editor failed.

E 802 No HEX data. The file format could not be read in the Hex-editor.

E 803 The file cannot be written. The Windows write-file function failed in the Hex-editor.

E 804
E 804 cannot open <file name>
abort <command name>

The Windows file-open function failed in the Hex-editor.

E 805
E 805 cannot open <file name>
abort "Load File"

When open a file in Hex editor, a NULL handle is 
returned.

E 806 Check sum error. Continue?
The hex-editor detected a faulty checksum. The 
checksum will be corrected, when continuing.

E 808 Invalid file name. The specified file could not be found in the Hex-editor.

E 809
E 809 <file name> could not be opened.
abort Save File

The Windows file-open function failed in the Hex-editor.

E 900
Unable to open last active PRM/SET file. Using 
most recent settings.

The FP4.INI file does not exist or contains invalid 
entries for RecentPrmFile or RecentSet-File. 
The first PRM file from sub-directory \PRM will be 
loaded instead.

E 901 Searching for fp4com.dll failed.
The communication DLL fp4com.dll is not available. 
Please re-install the FP4 software package

E 902 Unable to write to PRM file. 
Error message during maintenance mode only. No user 
action is required.

E 903
Unable to find any PRM file. Please install PRM 
files.

The sub-directory \PRM is either not existing or there is 
not PRM file available in this directory.

E 907 Download of PRM file failed.
Download of PRM returned an error. PRM file may 
contain errors.

E 908 Download of SET file failed.
Download of SET returned an error. SET file may 
contain errors.

E 909 This file is not valid A file opened for HEX editing contains empty lines.

E 910 Checking device name failed.
Erroneous signature data during Device Connect 
command.

E 911 Checking device end address failed.
Erroneous signature data during Device Connect 
command.

Table 12-4: GUI Error messages (3/3)

No. Message text Description
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12.5 GUI Information messages

Informational messages do not need any workaround because they do not force an error condition. The
message is send as information only and does not require any user action in response.

Table 12-5: GUI Information messages (1/2)

No. Message text Description

I 200

I 200 New firmware installed successfully in your 
programmer!

FP4 device setup has been invalidated by the 
firmware update.
Please setup device configuration again.

Firmware upgrade completed with success.

I 201
Opening parallel download port failed.
File download will be done on the serial port.

The Windows internal function to open the parallel port 
failed (port occupied by any other software?)

I 202 Download via parallel port failed.
Parallel port communication is not OK. Retry or use 
serial port for download.

I 300 Value out of range.
The value entered in a dialog box is out of the possible 
max/min range. The max/min value or the most recent 
value will be written into the dialog element.

I 301
Multiple Program Areas are disabled.
Please enable Program Areas usage in the 
Device Setup Dialog.

The menu command Programmer◊Select Programming 
area can only be used when it has been enabled in the 
advanced tab of the device setup dialog.

I 500 Operation completed successfully.
Executing a command succeeded. Most commands do 
not show this message.

I 501
This command can only be used for UC2 
devices.

The menu entries Device◊Write Security and 
Device◊Checksum can only be used for UC2 devices.

I 502
Note: To abort a write, erase or verify 

operation it is necessary to reset the
programmer manually.

Aborting device related commands require additional 
reset of the Programmer.

I 800 Buffer is modified. Are you sure to close?
The Hex-editor indicates that its contents is not yet 
saved to disk.

I 801 End record not found, created.
The Hex-editor has implicitly created an end record 
when loading a file.

I 802 The file is modified. Save?
The Hex-editor indicates that its contents is not yet 
saved to disk.

I 803 I 803 The file is modified. Save file?
Before close file, can choose save or not save the 
modification.

I 804 The file is modified. Are you sure to quit?
The Hex-editor indicates that its contents is not yet 
saved to disk.

I 805 This file is not valid. Try to open a invalid file in hex editor.

I 905 *.set is not valid. Using most recent settings. Using old format SET file will also occur this message.

I 906 *.prm is not valid. Using most recent settings. Using old format PRM file will also occur this message.

I 907
Caution: When 'Chip Erase’ is disabled, chip 
cannot be erased and programmed any more!

The warning is shown when the security flag is set in 
the advanced dialog.

I 908
I 908 Caution: When 'Boot block cluster repro-
gramming' is disabled, boot block cannot be 
erased and programmed any more!

The warning is shown when the flag “Disable Boot block 
cluster reprogramming” is set in the advanced dialog.

I 911 The selection is out of range.
Menu/Setup/Standard dialog/Speed is larger than the 
max value.
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I 912 The selection is out of range.
Menu/Setup/Standard dialog/Speed is smaller than the 
min value.

I 913 Value is out of range.
Menu Device/Setup/Standard dialog/Frequency or 
Multiply rate is larger than the max value.

I 914 Value is out of range.
Menu Device/Setup/Standard dialog/Frequency or 
Multiply rate is smaller than the min value.

I 915 The selection is out of range.
Menu Device/Setup/Advanced dialog/ Vdd[V] is out of 
range.

I 916 The selection is out of range. Menu Device/Upload dialog/ is out of range.

I 917 The selection is out of range.
Menu File/Setup/Advanced dialog/Range[hex] Start or 
End selection is out of range.

I 918 Input data is out of range
Data typed in for multiply rate in PLL mode exceeds the 
range of 0.01 to 99.99.

I 919
I 919 Caution: Boot Block swapping will not be 
possible with this selection.Anyhow, boot block 
protection is possible.

The warning is shown when change End Boot block in 
the advanced dialog.

Table 12-5: GUI Information messages (2/2)

No. Message text Description
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